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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2002 – 2005, 2007 Hewlett-Packard Development Company, L.P.

Trademark Notices

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.
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Support

You can visit the HP software support web site at:

http://support.openview.hp.com/support.jsp 

HP Software online support provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.

To find more information about access levels and HP Passport, go to:

http://support.openview.hp.com/new_access_levels.jsp 
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1 Introduction to HP OpenView Smart Plug-ins
HP OpenView Smart Plug-ins (SPIs) work in conjunction with HP OpenView Operations 
(OVO) to help you monitor, detect, solve, and prevent problems in your enterprise IT 
environment. The combination of OVO and SPIs enables you to simplify the following tasks in 
your IT resource:

• Monitoring availability and health

• Detecting performance lapse

• Detecting, preventing, and solving problems

• Documenting problem solutions

• Generating reports

OVO is a distributed client-server software. The central server, on which OVO is installed, is 
called the management server. OVO monitors systems in the network where your 
enterprise IT applications and resources are installed. These systems, which are monitored by 
OVO, are called managed nodes. The OVO agent, residing on every managed node, 
facilitates communication between the management server and the managed node.

A SPI is software that provides management capabilities to OVO specific to a particular 
enterprise application. You must install a SPI on the management server.
9



Figure 1 OVO Client-Server Architecture

Smart Plug-in for Microsoft Exchange Server

The Smart Plug-in for Microsoft Exchange Server (the Exchange SPI) enables  OVO to 
monitor Microsoft Exchange Server 2007, 2003, 2000, and 5.5. It enables you to monitor and 
manage your enterprise Exchange environment through predefined policies, which you can 
customize. These policies help you monitor server load, server performance, client availability, 
message delivery times, and service level objectives.

After you set up the Exchange SPI, you can view critical information about your Microsoft 
Exchange Server through OVO console in the form of:

• Message alerts

• Map view

• Reports and graphs
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• Topology viewer

 Message Alerts

The Exchange SPI monitors events and services on the managed nodes (servers on which the 
Microsoft Exchange Server is installed and the OVO agent is deployed) and generates 
messages, which are displayed on the message browser of OVO console. 

Figure 2 Message Alerts on OVO Console

 Map View

The map view of OVO presents a graphical and structural view of your Microsoft Exchange 
Server environment. The Exchange SPI discovers Exchange nodes and Exchange 
environment services and displays them in the map view. The map view displays the real-time 
status of your Exchange environment.
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Figure 3 Map View on OVO Console

The map view indicates severity levels problems in the Exchange organization with the help 
of colors  (red, yellow, blue, and green).

 Reports and Graphs

The reporting component, which is installed with HP OpenView Operations, gathers data 
collected by Exchange SPI data collection policies to generate reports. It captures and formats 
data collected at nodes and generates web based reports.

The graphing component generates graphs from near real-time data gathered from the 
managed nodes.

 Topology Viewer

The Exchange SPI enables you to view an Exchange organization graphically with the help of 
three-dimensional maps of routing groups and server connections. From the topology view you 
can quickly view routing groups, Exchange servers, and the roles they play within your 
Exchange organization.
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Figure 4 Topology Viewer

This release of the Exchange SPI does not provide Topology Viewer tool for Exchange Server 
2007.
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2 Installing the Exchange SPI
The Exchange SPI is packaged with the Smart Plug-ins, New and Upgraded CD. You must 
install the Exchange SPI on the OVO management server. The installation wizard guides you 
through the entire process of SPI installation.

Installation Procedure

To install the Exchange SPI on the management server, follow these steps:

1 Insert the Smart Plug-ins, New and Upgraded CD into the CD-ROM drive of the 
management server. The installation wizard opens.
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2 Click Next. The SPI Readme and Other Documentation screen appears.
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3 Click Next. The Product Selection screen appears.
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4 Select Microsoft Exchange Server, and then click Next. The License Agreement screen 
appears.

5 Select the I accept the terms...option, and then click Next. The Ready to Install the 
Program screen appears.
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6 Click Install. The installation begins.

7 The wizard installs the core SPIs, all necessary packages, and the Exchange SPI. After 
the installation is complete, click Finish.

Removing the Exchange SPI

Perform the following tasks to remove the Exchange SPI from the management server and the 
Exchange SPI policies from the managed nodes:

Task 1: Remove Policies from the Managed Nodes

1 On the OVO console tree, expand the folders HP OpenView → Operations Manager → Policy 
Management → Policy groups → SPI for Exchange.

2 Right-click SPI for Exchange, and then select All Tasks → Uninstall from...

3 In the Uninstall Policies on dialog box, select All Nodes.

4 Click OK.

Task 2: Delete Exchange SPI Policy Groups from the Management Server

1 In the console tree of the OVO console, select and expand the folder Policy Groups.

2 Right-click SPI for Exchange, and then select Delete.

Task 3: Delete Exchange SPI Tools from the Management Server

1 In the console tree of the OVO console, right-click Tools, and then select Configure → Tools.

2 In the Configure Tools dialog box, right-click SPI for Exchange, and then select Delete.

Check if there are any customized policies on the nodes and remove those.
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Task 4: Delete Exchange SPI Customized Policies from the Management Server

1 Navigate to Polices grouped by type.

2 For each Policy type group, right-click the group, and then select Set Filter....

3 Select the All versions of the policy below option, and then click OK.

4 Sort policies by name in the list box. Select all Exchange SPI policies.

5 Right click and select All tasks → Delete from server.

6 Repeat for all policy groups.

Task 5: Remove the Exchange SPI from the Management Server

1 From the Start menu, click Settings → Control Panel. The Control Panel window opens.

2 Double-click Add or Remove Programs. The Add or Remove Programs window appear.

3 Select hp OpenView New and Upgraded Smart Plug-ins from the list of programs, and 
then click Remove. The uninstallation wizard opens.

4 Click Next.

5 Select the Remove products option, and then click Next.

6 Click Finish when uninstallation is complete.

Installing the Exchange SPI in a Cluster Environment

Before you start installing the Exchange SPI in a cluster environment, make sure that OVO 
7.5 is installed on each system of the cluster. To install the Exchange SPI in an OVO cluster, 
follow these steps:

1 Insert the Smart Plug-ins, New and Upgraded CD into the CD-ROM drive of the first 
node of the OVO cluster. The installation wizard appears.

2 Follow the instructions in the wizard to install the SPI.

3 Repeat step 1 and step 2 on each node of the OVO cluster.

Removing the Exchange SPI from a Cluster Environment

To remove the Exchange SPI from a cluster OVO environment, follow these steps:

1 Remove the Exchange SPI policies from the managed nodes (see Task 1 on page 19).

2 Delete the Exchange SPI policy groups from each management server of the cluster (see 
Task 2 on page 19).

3 Delete the Exchange SPI tools from each management server of the cluster (see Task 3 on 
page 19).

4 Delete the Exchange SPI customized policies from each management server of the cluster 
(see Task 4 on page 20).

The OVO console does not function properly until you install the SPI on all nodes in the OVO 
cluster.
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5 From each management server, remove hp OpenView New and Upgraded Smart Plug-ins 
from the Add or Remove Programs window, and then select Microsoft Exchange Server in 
the Product Selection Uninstall screen to remove the Exchange SPI.

Alternatively, you can insert the Smart Plug-ins, New and Upgraded CD into the 
CD-ROM drive of each management server and remove the Exchange SPI.

Upgrading the Exchange SPI

If you have an older version of the Exchange SPI installed in your environment, you need to 
perform certain tasks to ensure an effective and optimal upgrade. To upgrade to the latest 
version of the Exchange SPI, follow these steps:

1 Identify the nodes on which you deployed earlier versions of the Exchange SPI.

2 Right-click one of the identified nodes, and then click View → Policy Inventory. The details 
pane displays the list of deployed policies.

3 Select all policies in the details pane, right-click, and then click All Tasks → Disable.

4 Select all policies in the details pane, right-click, and then click All Tasks → Remove.

5 Repeat step 2 to step 4 for all nodes on which you deployed earlier versions of Exchange 
SPI policies.

6 If you customized any of the policies, run the following commands on the management 
server:

ovpmutil cfg pol dnl C:\temp\ConfigDir /a 
ovpmutil cfg mdl dnl C:\temp\ConfigDir\model.mof 
ovpmutil cfg usr dnl C:\temp\ConfigDir\usroles.xml 

OVO saves the existing policy definitions in C:\temp\ConfigDir\.

7 Install the SPI from the CD by following the procedure described under Installation 
Procedure on page 15.

8 If you customized any of the policies, and made a backup of policies (step 6), run the 
following commands on the management server:

ovpmutil cfg pol upl C:\temp\ConfigDir\config.mm 
ovpmutil cfg mdl upl C:\temp\ConfigDir\model.mm
ovpmutil cfg usr upl C:\temp\ConfigDir\usroles.mm 

OVO retrieves all the policy information that you backed up in step 6.
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3 Configuring the Exchange SPI
After you install the Exchange SPI, you must add nodes on which Exchange servers reside to 
the management console. Also, you must deploy necessary policies and perform certain 
configuration tasks on the added managed nodes to begin the monitoring operation.

Configuring the Exchange SPI for Microsoft Exchange Server 
2007

The Exchange SPI will start monitoring a Microsoft Exchange Server 2007 node after you 
install the agent and deploy necessary policies on it. When you add a node, agents are 
automatically installed on the managed nodes.

Add Nodes

To add a new managed node, follow these steps:

1 In the console tree of the OVO console, right-click Nodes, and then click Configure → 
Nodes. The Configure Managed Nodes window opens.
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2 Drag and drop a system from the left frame to the right frame.

3 Click Apply.

4 Click OK.

After adding nodes, you must run the discovery policy on newly added nodes (See Deploy the 
Discovery Policy on page 24).

Deploy the Discovery Policy

To discover the Exchange environment on the nodes, you must deploy the discovery 
policies.Before you deploy the policy, you must provide the access credentials of a Microsoft 
Exchange Server 2007 user with administrative privileges. 

Provide User Credentials

If your Exchange organization consists of Exchange clusters, you must provide the Exchange 
2007 Discovery policy with the credentials of an administrative user. If you do not use 
Exchange server clusters, you can skip this procedure and deploy the discovery policy (see 
Deploy on Nodes on page 25). To provide the credentials of an administrative user to the 
Exchange 2007 Discovery policy, follow these steps:

1 In the console tree of the OVO console, expand Policy Management → Policy Groups  → SPI 
for Exchange → Exchange 2007 → Manual Deploy Groups, and then double-click Discovery.
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2 In the details pane, double-click Exchange 2007 Discovery. The Exchange 2007 Discovery* 
[11.10] (Service Auto-Discovery) dialog box opens.

3 In the User Editable Parameters pane, type the following information:

• In the User field, type user name of a user with administrative privilege along with 
the domain in the following format:

<Domain>/<User Name>

• In the Password field, type the password of the user.

• Retype the password in the Confirm Password field.

4 Close the Exchange 2007 Discovery* [11.10] (Service Auto-Discovery) dialog box.

Deploy on Nodes

To deploy the Exchange 2007 Discovery policy on managed Exchange nodes, follow these 
steps:

1 In the console tree of the OVO console, expand Policy Management → Policy Groups  → SPI 
for Exchange → Exchange 2007 → Manual Deploy Groups, and then double-click Discovery.

2 In the details pane, deploy the Exchange 2007 Discovery policy on the managed Microsoft 
Exchange Server 2007 nodes.
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Deploy Instrumentation

To deploy instrumentation on the newly added nodes, follow these steps:

1 In the console tree of the OVO console, right-click on a node, and then select All Tasks → 
Deploy Instrumentation. The Deploy Instrumentation dialog box opens.

2 Select SPI for Exchange 2007, and then click OK. 

3 Perform step 1 and step 2 for all added nodes.

Create Databases

After deploying the discovery policy, you must create databases on a data store. The Create 
Data Sources tool creates databases on the OVO agent’s data store (embedded performance 
component — also known as CODA). If you do not run this tool and create databases, the 
agent cannot log messages on the managed node. To run this tool, follow these steps:

1 In the console tree of the OVO console, expand Tools → SPI for Exchange, and then 
double-click Exchange 2007.
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2 In the details pane, double-click Create Data Sources. The Select where to launch this tool 
dialog box opens.

3 Select the nodes on which you want to run the tool, and then click Launch. After a few 
seconds, the Tool Status window opens.

4 Click Close.
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Run the Register DataCollector Tool

This tool registers COM components on the managed Exchange 2007 nodes. To run the 
Register DataCollector Tool, follow these steps:

1 In the console tree of the OVO console, expand Tools → SPI for Exchange, and then 
double-click Exchange 2007.

2 In the details pane, double-click Register DataCollector. The Select where to launch this tool 
dialog box opens.

3 Select the nodes, and then click Launch. After a few seconds, the Tool Status window 
opens.

4 Click Close.

Run the Start ExData Collection Manager Tool

To facilitate the data collection mechanism on managed nodes, the SPI for Microsoft Exchange 
Server 2007 uses collection manager, which is a background process that runs on managed 
Exchange 2007 nodes. Before you start using the SPI, you must run the Start ExData 
Collection Manager tool on managed Exchange 2007 nodes to enable data collection. To run 
the Start ExData Collection Manager tool on Exchange 2007 nodes, follow these steps:

1 In the console tree of the OVO console, expand Tools → SPI for Exchange, and then 
double-click Exchange 2007.
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2 In the details pane, double-click Start ExData Collection Manager. The Select where to 
launch this tool dialog box opens.

3 Select the nodes on which you want to run the tool, and then click Launch. After a few 
seconds, the Tool Status window opens.

4 Click Close.

Run the Start PowerShell Collector Tool

The SPI for Microsoft Exchange Server 2007 uses PowerShell commands to collect metric 
values. PowerShell collector is a background process, that runs on managed nodes, and works 
in conjunction with collection manager to facilitate data collection. To run the Start 
PowerShell Collector tool on Exchange 2007 nodes, follow these steps:

1 In the console tree of the OVO console, expand Tools → SPI for Exchange, and then 
double-click Exchange 2007.
Configuring the Exchange SPI 29



2 In the details pane, right-click Start PowerShell Collector, and then click Properties. The 
Start PowerShell Collector Properties dialog box opens.

3 Go to the Target tab.
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4 Clear the Run As Agent User Option.

5 In the User Name text box, type a user name with the Exchange View Only 
administrative privilege.

6 In the Password and Verify Password text boxes, type the password for the above user.

7 Click Apply.

8 Click OK.

9 In the details pane, double-click Start PowerShell Collector. The Select where to launch this 
tool dialog box opens.

10 Select the nodes on which you ran the Start Collection Manager tool, and then click 
Launch. After a few seconds, the Tool Status window opens.

11 Click Close.

Deploy the Refresh Collection Definition Policy

The PowerShell collection configuration utility enables you to modify the default collection 
definition by modifying the SPIMetaData.xml file. Every time you modify the 
SPIMetaData.xml file, you must deploy the EXSPI-8.X SPIMetaData Versioning policy on 
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nodes for the modifications to take effect. However, the collection manager process starts 
following the updated collection mechanism only after you deploy the Refresh Collection 
Policy. To deploy the Refresh Collection Definition policy, follow these steps:

1 In the console tree of the OVO console, expand Policy Management → Policy groups → SPI for 
Exchange → Exchange 2007 → Manual Deploy Groups, and then double-click Collector 
Definition.

2 In the details pane, right-click Refresh Collection Definition, and then click All Tasks → 
Deploy on. The Deploy policies on dialog box opens.

3 Keep all default settings and select nodes from the Managed nodes list.

4 Click OK.
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Deploy the Check Collector Server Policy

The Check Collector Server policy checks the status of the PowerShell collector process on 
managed nodes. You must deploy this policy to all added Microsoft Exchange Server 2007 
nodes. To deploy the Check Collector Server policy on nodes, follow these steps:

1 In the console tree of the OVO console, expand Policy Management → Policy groups → SPI for 
Exchange → Exchange 2007 → Manual Deploy Groups, and then double-click Collector 
Definition.

2 In the details pane, right-click Check Collector Server, and then click All Tasks → Deploy on. 
The Deploy policies on dialog box opens.

3 Keep all default settings and select nodes from the Managed nodes list.

4 Click OK.
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Deploy the Check Collection Manager Policy

The Check Collection Manager policy checks the status of the collection manager process on 
managed nodes. You must deploy this policy to all added Microsoft Exchange Server 2007 
nodes. To deploy the Check Collection Manager policy on nodes, follow these steps:

1  the console tree of the OVO console, expand Policy Management → Policy groups → SPI for 
Exchange → Exchange 2007 → Manual Deploy Groups, and then double-click Collector 
Definition.

2 In the details pane, right-click Check Collection Manager, and then click All Tasks → Deploy 
on. The Deploy policies on dialog box opens.

3 Keep all default settings and select nodes from the Managed nodes list.

4 Click OK.
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Configuring the SPI for Microsoft Exchange Server 2003 and 
2000

If policy autodeployment is enabled on the management server, add the managed nodes 
according to the instructions in Add Nodes on page 35, deploy instrumentation on nodes 
according to the instructions in Deploy Instrumentation on page 36, and then start using the 
SPI.

If policy autodeployment is disabled on the management server, you must perform the 
following configuration tasks.

Add Nodes

To add a new managed node, follow these steps:

1 In the console tree of the OVO console, right-click Nodes, and then click Configure → 
Nodes. The Configure Managed Nodes window opens.

2 Drag and drop a system from the left frame to the right frame.

3 Click Apply.

4 Click OK.
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Deploy Instrumentation

To deploy instrumentation on the newly added nodes, follow these steps:

1 In the console tree of the OVO console, right-click on a node, and then select All Tasks → 
Deploy Instrumentation. The Deploy Instrumentation dialog box opens:

2 Select SPI for Exchange 200X, and then click OK. 

3 Perform step 1 and step 2 for all the added nodes.

If the policy autodeployment is enabled, you can start using the SPI. 

If the policy autodeployment is disabled, you must run the discovery policy on newly added 
nodes (see Deploy Discovery Policy on page 36).

Deploy Discovery Policy

For Microsoft Exchange Server 2003 or 2000, you must deploy the Discovery policy under 
Exchange 2003. To deploy this policy on managed nodes, follow these steps:

1 In the console tree of the OVO console, expand Policy Management → Policy Groups  → SPI 
for Exchange → Exchange 2003 → ovo Exchange SPI core or Policy Management → Policy 
Groups  → SPI for Exchange → Exchange 2003 → ovo Exchange SPI core, and then click 
Discovery. 

2 In the right pane, deploy the EXSPI-6.X Exchange Service Discovery policy.
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Create Databases

After deploying the discovery policy, you must create databases on a data store. The Data 
Collection policy can create databases on the OVO agent’s data store (embedded performance 
component — also known as CODA). If you do not deploy this policy and create databases, the 
agent cannot log messages on the managed node. To create databases in a data store, follow 
these steps:

1 In the console tree, expand Policy management → Policy groups → 
SPI for Exchange →  Exchange 2003 → Auto Deploy Groups → ovo Exchange SPI core or Policy 
management → Policy groups → 
SPI for Exchange →  Exchange 2000 → Auto Deploy Groups → ovo Exchange SPI core, and 
then click Data Collection.

2 In the details pane, deploy the EXSPI-6.X exspi Agent Configuration policy on the nodes 
of your choice.

Configuring the SPI for Microsoft Exchange Server 5.5

To use certain tools and policies on Exchange 5.5 nodes, you must provide the Exchange SPI 
with an administrative user credential of Exchange 5.5.

• If policy autodeployment is enabled:

a Create Administrative User Credentials on Microsoft Exchange Server 5.5

b Add User Name and Password to the EXSPI-5.5 Exchange Service Discovery Policy

c Add Nodes

d Deploy Instrumentation

• If policy autodeployment is disabled:

a Create Administrative User Credentials on Microsoft Exchange Server 5.5

b Add User Name and Password to the EXSPI-5.5 Exchange Service Discovery Policy

c Add Nodes

d Deploy Instrumentation

e Run Discovery Policy

f Create Databases

Create Administrative User Credentials on Microsoft Exchange Server 5.5

To use the SPI for Exchange 5.5, you must provide user credentials with administrative 
privileges to the Exchange SPI. You must create an administrative account for each Windows 
domain where OVO-managed Exchange servers reside.This account enables the Exchange 
SPI to access information from the Exchange database. To create administrative users for 
windows domain (for Windows NT Domain or Windows 2000 Domain), follow these steps:

Make sure that the version of Windows NT you are using is supported by OVO for Windows 
7.5.
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Create Administrative User for Windows NT Domain

Perform the following tasks to create users with administrative rights in Windows NT 
domain:

Task 1: Create a Service Account

To create a service account, follow these steps:

1 Log on as Domain Administrator of the domain to which the Exchange server belongs. 

2 From the Start menu, select Programs → Administrative Tools (common) → User Manager for 
Domain. The User Manager window opens.

3 Click User → New User. The New User dialog box opens.
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4 Specify the following details in the New User dialog box:

5 Specify the following options in the New User dialog box:

6 Click Groups. The Group Memberships dialog box opens.

7 From the Not member of list, click Domain Admins users, click Add, and then click OK.

8 In the New User dialog box, click the following buttons to enter necessary information:

Field Description

Username Type a name of the user.

Full Name Type a descriptive name of the above user.

Description Type a description of the account.

Password Type a password.

Confirm Password Re-type the password entered above.

You must create a service account with these privileges in each Windows domain. 
Name the account MSXSPI. Throughout this document the account is referred to 
as MSXSPI, which is the required user name for the service account. 

Option Description

User Must Change 
Password at Next Logon

Do not select this option.

User Cannot Change 
Password

Do not select this option.

Password Never Expires Select this option.

Account Disabled Do not select this option.
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9 In the New User dialog box, click Add (if the Exchange Add Mailbox window opens, click 
Cancel). 

10 Click Close.

11 In the User Manager window, click Policies → User Rights from the menu bar. The User 
Rights Policy dialog box opens.

12 Select the Show Advanced User Rights option.

13 From the right drop-down box, select Log on as a service.

Profile Do not specify any user profile.

Hours All hours of the day and week should be allowed.

Logon To Specify all workstations.

Account Should never expire/should be Global Account.
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14 Click Add. The Add Users and Groups dialog box opens.

15 Click Show User.

16 Select the newly added service account (select the name specified in step 4 on page 39), 
click Add, and then click OK.

17 Repeat step 13 to step 16 to add the Profile system performance. 

Task 2: Grant Exchange Access Permissions to the Service Account

The service account must have Exchange Admin permissions to access a mailbox, Exchange 
IS Public database, and Exchange IS Private database. To grant Exchange access permission 
to the service account you created, follow these steps:

1 From the Start menu, select Programs → Microsoft Exchange  → Microsoft Exchange 
Administrator.

2 For each Exchange site where the affected policies are to be deployed:

a In the left pane within the tree, select <site_name>.

b From the File menu select Properties.

c In the Properties window, select the Permission tab, and then click Add. The Add 
Users and Groups window opens.

d Select the newly created service account (select the username specified in step 4 on 
page 39), and then click Add.

e Click OK to add the user, and then close the Add Users and Groups window.
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f Verify the user has the role of Admin.

3 Click OK to save the changes.

Create Administrative User for Windows 2000 Domain

Task 1: Create a Service Account

1 Log on to the system that hosts the managed node’s domain.

2 From the Start menu, select Programs → Administrative Tools → Active Directory Users and 
Computers.
42 Chapter 3



3 From the menu bar, click Action → New → User. The New Object - User dialog box opens.

4 Type a user name for the service account in the First Name and in the User logon name 
text boxes.

5 Click Next.

You must create a service account with these privileges in each Windows domain. 
Name the account MSXSPI. Throughout this document the account is referred to 
as MSXSPI, the required user name for the service account.
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6 Type Password/Confirm Password for the service account.

7 Select the Password never expires option.

8 Click Next.
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9 Clear the Create an Exchange mailbox option, and then click Next.

10 Click Finish.

11 In the Active Directory Users and Computer window, double-click Users in the right pane.

12 In the right pane, right click the newly created user, and then click Properties.The 
Properties dialog box opens.
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13 Select the General tab, and then type OVO Exchange SPI in the Display name and 
Description text boxes.
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14 Select the Member of tab, and then click Add. The Select Groups dialog box opens.

15 Select Domain Admins from the top pane.
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16 Click Add, and then click OK. The new user is now a member of the Domain Admins group.

17 Click OK.

Task 2: Grant Exchange Access Permissions to the Service Account

The service account must have Exchange Admin permissions to access a mailbox, Exchange 
IS Public database, and Exchange IS Private database. To grant Exchange access permission 
to the service account created above, follow these steps:

1 From the Start menu, select Program → Microsoft Exchange → Microsoft Exchange 
Administrator.

2 For each Exchange site where affected policies are to be deployed:

a In the left pane within the tree, select <site_name>.

b From the File menu, click Properties.

c In the Properties window, select the Permission tab, and then click Add. The Add 
Users and Groups window appears.

d Select the newly created service account (select the username specified in step 4 on 
page 43), and then click Add.
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e Click OK.

f Verify the user has the role of Admin.

g Click OK to save the changes.

Add User Name and Password to the EXSPI-5.5 Exchange Service Discovery 
Policy

When the SPI is installed, open the EXSPI-5.5 Exchange Service Discovery policy in the 
Policy Management → SPI for Exchange → Exchange 5.5 → EXSPI Discovery folder on the 
OVO console. Add the User name and Password of a service account with administrative 
Exchange privileges.
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Add Nodes

To add a new managed node, follow these steps:

1 In the console tree of the OVO console, right-click Nodes, and then click Configure → 
Nodes. The Configure Managed Nodes window opens.

2 Drag and drop a system from the left frame to the right frame.

3 Click Apply.

4 Click OK.
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Deploy Instrumentation

To deploy instrumentation on the newly added nodes, follow these steps:

1 In the console tree of the OVO console, right-click on a node, and then select All Tasks → 
Deploy Instrumentation. The Deploy Instrumentation dialog box opens.

2 Select SPI for Exchange, and then click OK. 

3 Perform step 1 and step 2 for all added nodes.

If the policy autodeployment is enabled, you can start using the SPI. 

If the policy autodeployment is disabled, you must run the discovery policy on newly added 
nodes (see Run Discovery Policy on page 51).

Run Discovery Policy

For Microsoft Exchange Server 5.5, you must run the Discovery policy under Exchange 5.5. To 
run this policy on managed nodes, follow these steps:

1 In the console tree of the OVO console, expand Policy Management → Policy Groups  → SPI 
for Exchange → Exchange 5.5, and then double-click EXSPI Discovery. 

2 In the right pane, deploy the EXSPI-5.5 Exchange Service Discovery policy.
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Create Databases

After deploying the discovery policy, you must create databases on a data store. The EXSPI 
General Data Collection policy can create databases on the OVO agent’s data store (embedded 
performance component — also known as CODA). If you do not deploy this policy and create 
databases, the agent cannot log messages on the managed node. To create databases in a data 
store, follow these steps:

1 In the console tree, expand Policy management → Policy groups → 
SPI for Exchange →  Exchange 5.5 → EXSPI Quick Start, and then click EXSPI General Data 
Collection.

2 In the details pane, deploy the EXSPI-5.5 Create Coda Data Sources policy on the nodes of 
your choice.
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4 Configuring Exchange SPI for Message Delivery 
SLAs
The Exchange SPI enables you to monitor message delivery performance of Exchange Server 
and compare the performance against Service Level Agreements (SLAs) of your organization. 
The SPI monitors message delivery and detects SLA violations by using end-to-end message 
ping.

Exchange 2007: Testing MAPI Connectivity

You can test the message delivery performance of Mailbox servers with the EXSPI-8.X Test 
Mapi Connectivity policy. You can test the MAPI connectivity latency and error by deploying 
this policy. The default MAPI connectivity latency is set at 10. If MAPI connectivity latency 
exceeds this threshold or if any error occurs during this test, the policy sends alert message to 
the message browser. You can change this MAPI connectivity latency threshold by using the 
PowerShell collection configuration utility.

To test the MAPI connectivity latency by setting a new threshold, perform these tasks:

Task 1: Change the Threshold Value 

1 Go to the PowerShell collection configuration utility.

2 In the left pane, expand Collection Components → OpcMsg. 

3 In the left pane, click TestMapiLatency. 

4 In the right pane, click Delete to delete the existing threshold. 

5 Select TestMapiConnectivity from the MetricSetRef drop-down box. 

6 Select Latency from the MetricRef drop-down box. 

7 Select GreaterThanOrEQ from the Select Arithmetic Operator drop-down box. 

8 Set the threshold value in the value to compare box. 

9 Click Add. 

10 Click Apply Changes.

11 Click File  → Save.

Task 2: Identify Nodes

1 Identify the nodes on which you want to run the test.

2 In the left pane of the OVO console, expand Policy management → Policy groups → SPI for 
Exchange → Exchange 2007 → Manual Deploy Groups, and then click Collector Definition.

3 In the details pane, right-click EXSPI-8.X SPIMetaData Versioning, and then click All Tasks → 
Update to latest.

4 Deploy the EXSPI-8.X SPIMetaData Versioning policy on the selected nodes.
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Task 3: Deploy the Policy 

Deploy the EXSPI-8.X Test Mapi Connectivity policy on the selected nodes to check if the 
latency is within the threshold value.

Exchange 2000/2003: Monitoring Message Delivery SLAs

Use the Exchange SPI End-to-End Message Ping to monitor message delivery SLAs. The 
End-to-End Message Ping procedure requires performing the following tasks in the order 
given.

Task 1: Create a New Source Mailbox for Each Source Server

A mailbox needs to be created on each OVO managed Exchange 2000 or Exchange 2003 server 
from which the Ping messages will be sent out

1 In the OVO manager console, expand the Tools → SPI for Exchange → Exchange 2000 and 
2003 → End-to-End SLA Configuration folder.

2 In the details pane, double-click MBOX Config. The Select where to launch this tool dialog 
box opens.
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3 Select the nodes on which you want to launch the tool, and then click Launch. The Edit 
Logins and Parameters dialog box opens.

4 If you want to specify the organizational unit and mailbox prefix:

a Select the Parameters tab. By default, the organizational unit is set to Users, and the 
default mailbox prefix ID is msxspi, so the user/mailbox name will be msxspi<server 
name>. 

b Create the mailbox name with a prefix ID, followed by the Windows hostname, with 
no spaces: <prefix ID><server name>. For example, msxspi<server name>.

c Select the Login tab. Type the User name and password for a user who has the 
privilege to create Users with mailboxes in this domain.

d Click Launch.

Task 2: Run the End-to-End ConfigurationWizard to configure SLAs

You must set message delivery SLAs of your organization by using the End-to-End 
Configuration tool.

1 In the console tree, expand the Tools → SPI for Exchange → Exchange 2000 and 2003 → 
End-to-End SLA Configuration folder.

2 In the details pane, double-click End-to-End Configuration.

3 Confirm the introductory dialog, which gives an example of a typical SLA by clicking Next.

4 Select the Exchange SPI configuration setting that best matches your SLA, and then click 
Next.
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5 Select the Source Servers from the list of OVO managed servers. A source server is a 
server from which an email is sent. 

6 Click Next.

7 Select the Destination Servers from the list. These can be any Exchange servers within 
your organization, not only OVO managed Exchange servers. 

8 Click Next.

9 Specify the Service Level Agreement by assigning the thresholds (in seconds) for Timeout, 
Met SLA, and Almost met SLA. 

10 Click Next.

11 Confirm or make changes to the SLAs, and then click Next.

12 Select to deploy all End-to-End Policies to the managed nodes. Only managed nodes 
configured to determine SLAs will send and receive mail. 

 

13 Click Next.

14 Click Finish, and then click OK.

You can also perform this step manually by deploying SPI for Exchange 200X 
instrumentation and the EXSPI End-to-End Message Ping policy (Manual Deploy 
Groups → Exchange Server → Message Delivery folder) to any desired managed 
nodes.
56 Chapter 4



Figure 5 Example SLA thresholds, where Met SLA=60, Almost met SLA=60, Time 
Out=300

You must run the wizard whenever you add a new Exchange server as a 
managed node, if an SLA is to be monitored on the newly managed server.
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Exchange 5.5: monitoring message delivery SLAs

Use the EXSPI-End-to End Message Ping policy in the Exchange 5.5 EXSPI Advanced policy 
group to determine SLA performance by sending and receiving messages.

To configure and deploy the EXSPI End-to-End Message Ping, perform the following tasks in 
the order given:

Task 1: Create a Service Account with Special Administrative Privileges

See Create Administrative User Credentials on Microsoft Exchange Server 5.5 on page 37.

Task 2: Create Mailboxes

The service account needs a mailbox on every targeted Exchange server to access Exchange 
mailbox and folder information. 

To create a mailbox for the service account, follow these steps:

1 In the console tree, expand Tools → SPI for Exchange → Exchange 5.5 folder.

2 In the details pane, double-click MBOX Config.

3 Select the servers the tool should launch on.

4 Click Launch to start the tool running on the selected nodes.

5 When prompted, type the service account user name and password.   
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If you cannot automatically create mailboxes and receive an error, try to 
manually create a mailbox for each Exchange server with the prefix MSXSPI 
and NT hostname. For example, the node rosspidb5.rose.hp.com (Internet 
name) and NT name ROSSPIB5 require a mailbox called 
MSXSPIROSSPIDB5 with primary NT account MSXSPI. 
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Task 3: Set up Server Connections to Test Message Delivery/Receipt 

The EXSPI-5.5- Ping Config policy in the EXSPI Advanced group tracks the round trip time of 
a message. Before deploying the policy, the servers you want to monitor must be added to this 
policy.

1 Open the policy Ping Config. 

2 Edit the text in the policy with your Exchange environment information. Only one policy 
is needed since you are able to designate at this level which server the configuration line 
is valid for. When finished, click Save and Close.  

Examples:

#     EXCH1::::MSXSPIEXCH2:25m:1m:1m 
#     EXCH1:MSXSPIEXCH1:::MSXSPIEXCH3:2h:5m:2m 
#     EXCH2:MSXSPIEXCH2:::MSXSPIEXCH4:1h:20m:10m 
#     EXCH3:MSXSPIEXCH3:::MSXSPIEXCH4:25m:5m:5m 

Example

Enter server information to replace each entry separated by a colon (:). Each uncommented 
line represents a Service Level Agreement configuration. 

# Format of the file:
# Src-Svr:Src-MB:::Dest-MB:Timeout:MetSLA:AlmostMetSLA 

# Src-Svr = Source Server (required) 

# Src-MB = Source Mailbox (optional)
Defaults to 'MSXSPI<host_name>'. 

# Reserved = Reserved for future use, leave empty 

# Reserved = Reserved for future use, leave empty 

# Dest-MB = Destination Mailbox (required) 

# Timeout = Timeout (required)
 (s-seconds, m-minutes, h-hours) 

# MetSLA = Met SLA time (require for reports)
 (s-seconds, m-minutes, h-hours) 

# AlmostMetSLA = Almost met SLA time (require for reports) 
(s-seconds, m-minutes, h-hours) 
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In the following example of Ping Config policy text: ServerA will use Mailbox 
"MSXSPIServerA" to send a message to mailbox MSXSPIServerB. Server A will ignore the 
information in the line that starts with ServerC. There should be no white spaces at the 
beginning of lines. Lines beginning with # are comments and are ignored:

ServerA:MSXSPIServerA:::MSXSPIServerB:2h:5m:2m

ServerC::::MSXSPIServerA:20h:1m:1m  

# End File # __________#   

Definition of Terms

— Source Server (required) — The server that the ping originates from. Each server 
where Exchange SPI is distributed has the same file, so THE Exchange SPI can parse 
this file and use all lines where the Source Server matches the server where it is run 
from.

— Source Mailbox (optional) — The mailbox to send the mail from. If this is not 
included, a default account is used “MSXSPI<host_name>” where <host_name> is 
replaced with the name of the server.

— Destination Mailbox (required) — The mailbox to send the ping to. This field is 
usually the only required destination entry.

— Timeout (required) (s-seconds, m-minutes, h-hours) — If a sent message does not 
return in the defined timeout interval, EXSPI logs it as a failure and sends a message 
to the OVO management server. Failed messages are tallied in terms of count and 
percentage within a report. The timeout value must be larger than the values for 
MetSLA and AlmostMetSLA so that a returned message can be processed using these 
values. It may have Exceeded SLA even though it did not exceed the timeout interval. 
A Failed/Timedout message occurs only when the message does not return before the 
timeout period is exceeded.  

— MetSLA (required for reports) (s-seconds, m-minutes, h-hours) — If the round trip 
time is greater than this value, the message is logged as either Almost Met SLA or 
Exceeded SLA. This value is required if data is being sent to the Measurement Data 
Collector Agent DSI for reporting (-l option when running exspi.exe). It is optional if 
only using alarms.

— AlmostMetSLA (required for reports) (s-seconds, m-minutes, h-hours)  — If the 
round trip time is greater than the MetSLA value but less than or equal to MetSLA 
plus AlmostMetSLA, the message is logged as Almost Met SLA. Otherwise, when the 
round trip time is higher than MetSLA plus AlmostMetSLA, it is logged as Clearly 
Exceeded SLA. This parameter is required if data is being logged to the data collection 
Agent DSI (-l option when running exspi.exe), optional if only using alarms.  

The minimum timeout value should be set slightly less than the collection 
interval. For example, if the collection interval for metric 1002 is 30 minutes 
(the default), the timeout should be set to at least 25 minutes. The logic is 
that because the next measurement occurs only every 30 minutes, you should 
allow up to that amount of time for any messages to return before “giving up” 
and generating a failure. If you keep the timeout value within the collection 
interval and the reply message does return, it can be processed as Met, 
Almost Met, or Exceeded as opposed to Failed/Timedout. 

Timeout, MetSLA, and AlmostMetSLA values can have optional identifiers 
that denote the measurement units the value represents; for example, 4m (4 
minutes) 30s (30 seconds) or 1h (1 hour). The default unit is seconds; for 
example, the entry 4 by default is recognized as 4 seconds. 
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Examples:

EXCH1::::MSXSPIEXCH2:25m:1m:1m
Use the default FROM mailbox of MSXSPIEXCH1. Message must return within 1 minute 
to meet the SLA, 2 minutes to almost meet the SLA, and at over 25 minutes a failure/
timeout is generated.

EXCH1:MAILBOXEXCH1:::MAILOXEXCH3:2h:5m:2m 
Message must return within 5 minutes to meet the SLA, 7 minutes to almost meet the 
SLA, and at over 2 hours a failure/timeout is generated.

EXCH2:MAILBOXEXCH2:::MAILOXEXCH4:1h:20m:10m
Message must return within 20 minutes to meet the SLA, 30 minutes to almost meet the 
SLA and at over 1 hour a failure/timeout is generated.

Task 4: Set up EXSPI End-to-End Message Ping Alarms—Configure Server Pair Thresholds 

Alarms can be set to occur with metric 1002 (Ping). As you may need to set different 
thresholds for multiple server pairs, some examples are included here to clarify the procedure. 
These examples show the syntax to insert in the exspilnk.txt file to set differing thresholds. 
Metric 1002 sends the “FromMailbox,ToMailbox” in the object pattern fields with the 
following definitions:

FromMailbox = FromServer:FromMailbox

ToMailbox    = :ToMailboxl   

Requirement: When you configure server connections, you must start the 
EXSPI Admin tool EXSPI Ping Config from the OVO management server. 

Config Entry Object 

EXCH1::::MSXSPIEXCH2:25m:1m:1m EXCH1:MSXSPIEXCH1,:MSXSPIEXCH2 

EXCH1:MAILBOXEXCH1:::

MAILOXEXCH3:2h:5m:2m 

EXCH1:MAILBOXEXCH1,:MAILOXEXC
H3 

EXCH2:MAILBOXEXCH2:::

MAILOXEXCH4:1h:20m:10m 

EXCH2:MAILBOXEXCH2,:MAILOXEXC
H4 
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Task 5: Modify the Policy to Include the Service Account Password

Before deploying the EXSPI End-to-End Message Ping policy, you must edit it to include the 
service account name and password, so that it has access to data on the Exchange server 
system. 

1 Open the OVO console and expand the Policy Management folder.

2 In the console tree, select Policy groups → SPI for Exchange → Exchange 5.5 → EXSPI 
Advanced → EXSPI End-to-End Message Ping group.

3 In the details pane, right-click EXSPI-5.5-End-to-End Message Ping, and then select All Tasks 
→ Edit.

4 In the dialog that appears, confirm or type the service account user name (MSXSPI), select 
the Specify Password option, and type the password you assigned to the service account.

5 Click Save and Close.

Task 6: Deploy the Configuration File and the Policy

1 In the console tree, expand the folders Policy management → Policy groups → SPI for 
Exchange → Exchange 5.5 → EXSPI Advanced.

2 In the EXSPI Advanced folder, double-click the Advanced policy sub-group you want to 
deploy. 

3 In the details pane where all the policies and/or configuration files are now listed, select 
the policies and/or configuration file needed, right-click, and then select Deploy on....

4 In the Deploy policies on... dialog box, select all nodes by clicking the check box next to 
Nodes, or select individual nodes by clicking the adjacent checkbox.

Condition Name & 
Type

Condition Object 
Pattern Threshold Explanation

EXSPI-1002.1
+Message on
Matched Condition

EXCH1:MSXSPIEXCH1, 
:MSXSPIEXCH2

120 Threshold condition for ping 
between System EXCH1 and 
mailbox MSXSPIEXCH2 on 
system EXCH2. Object 
pattern is case sensitive.

EXSPI-1002.2
+Message on 
Matched Condition

EXCH1:MSXSPIEXCH1, 
:MSXSPIEXCH3

240 Threshold condition for ping 
between System EXCH1 and 
mailbox MSXSPIEXCH3 on 
system EXCH3. Object 
pattern is case sensitive.

EXSPI-1002.3
-Suppress 
Matched Condition

EXCH1:MSXSPIEXCH1, 
:MSXSPIEXCH2
EXCH1:MSXSPIEXCH1, 
:MSXSPIEXCH3

If the threshold was not 
exceeded for these two 
system pairs, you must 
suppress the message if 
either of these system pairs 
gets past 1002.1 or 1002.2.

EXSPI-1002.4
+Message on 
Matched Condition

60 A blank object pattern to 
catch all remaining system 
pairs.
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Format of Objects Passed from the Exchange SPI Executable to the Metric 1002 for 
End-to-End Message Ping

The exspi_e55.exe executable is used to pass objects to the monitoring Measurement 
Threshold Policy EXSPI-5.5-1002. This monitor evaluates the End-to-End Message Ping and 
is used to check if the SLAs for the turnaround-time of a mail time are met. The executable 
passes a message back to the Measurement Threshold Policy to match the Object name in the 
following format:

A:B:C:D:E:F 

The format has the following meaning:

– A is one of the strings: 
["SLAViolation"|"SLAWarning"|"Timeout"|"Undeliverable"].

– B is Source node.

– C is Source Mailbox.

– D is Destination Node.

– E is Destination Mailbox.

– F is one of the following, depending on A: [SLA Threshold|Warning 
Threshold|Timeout Threshold].

According to this format, the default policy has four rules that match on the Object A. 
According to the value of A, a message is created and sent to the OVO Message Browser.
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Comparison: End-to-End Message Ping for Exchange 5.5 v. 
Exchange 2000/2003

— The Exchange SPI End-to-End Message Ping for Exchange 2000 and Exchange 2003 
servers sends the ping message to the System Assistant account of a destination 
Exchange 2000/2003 server. Therefore, there is no need to configure a receiving 
mailbox. 

— The ping messages received by the System Assistant will be automatically deleted by 
the Exchange 2000/2003 server and do not need to be manually deleted from the 
receiving mailbox by the Exchange SPI user.
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5 Exchange SPI Clustering Support
You can use Microsoft Exchange Server 2007 and 2003/2000 in a cluster environment where 
the fail-over capability of Exchange Servers ensures uninterrupted Exchange availability. In 
the event of a cluster node failure, the Exchange SPI automatically switches monitoring 
activity from the failed node to the active node.

Configuring Exchange SPI for a Cluster Environment

The Exchange SPI recognizes Exchange instances in an Exchange cluster by using XML 
configuration files (apminfo.xml and msexchange.apm.xml). In the event of failure, these 
XML files enable the OVO agent to automatically perform the following functions:

• Disable instance monitoring on the inactive node

• Enable instance monitoring on the currently active node

To configure the Exchange SPI for a cluster environment, perform the following tasks in the 
order given. 

Task 1: Add the Exchange Cluster Nodes to OVO Console

Identify the cluster nodes of your Exchange environment, and then add those nodes to OVO 
console.

If policy autodeployment is disabled, you must launch the necessary policies on newly added 
cluster nodes.

The discovery policy discovers the Exchange cluster and updates the map with cluster 
topology. 

Task 2: Generate Cluster Application Configuration File

You must generate the apminfo.xml file to describe the cluster instances (Exchange virtual 
servers).

1 Launch the Exchange Cluster Configuration tool on the cluster nodes. 

2 For Exchange 2003 and 2000, in the console tree, expand Tools → SPI for Exchange → 
Exchange 2000 and 2003 → ovo Utilities folder.

For Exchange 2007, in the console tree, expand Tools → SPI for Exchange → Exchange 2007.
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3 In the details pane, double-click Exchange Cluster Configuration. The Select where to 
launch this tool dialog box opens.
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4 Click Launch. The Tool Status window appears and displays the output under the Tool 
Output section.

5 Select the text content under the Tool Output section, and then copy it to a text editor.

6 Save the text as apminfo.xml in the following locations on cluster nodes:

<installation_directory>/Installed Packages
/{790C06B4-844E-11D2-972B-080009EF8C2A}/conf/OpC/ 

7 Stop and start the agents on the nodes by using the following commands:

opcagt -stop
opcagt -start

Example apminfo.xml File

In the following example, ExchResGroup1 and ExchResGroup2 are the names of the Exchange 
resource groups corresponding to EXCHVIRTSERV1 and EXCHVIRTSERV2 instances (virtual 
servers):

<?xml version="1.0" ?>
<APMClusterConfiguration>
  <Application>
    <Name>msexchange</Name>
      <Instance>
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         <Name>EXCHVIRTSERV1</Name>
         <Package>ExchResGroup1</Package>
       </Instance>

<Instance>

<Name>EXCHVIRTSERV2</Name>
         <Package>ExchResGroup2</Package>
       </Instance>

  </Application>
</APMClusterConfiguration> 

Figure 6 Example of Exchange Resource Group   

Additional Configuration for Policy Name Change

The Exchange SPI disables all policies from a cluster node if the node fails, and then enables 
all policies on the active cluster node. While switching its operation from disabled node to 
active node, the Exchange SPI retrieves policy information from the msexchange.apm.xml 
file. If you change any policy name (or add a new policy) and deploy the changed policy on a 
managed cluster node, you must reflect the change in the msexchange.apm.xml file as well. 
To update the  msexchange.apm.xml file with changed policy information, follow these 
steps:

1 Open the msexchange.apm.xml file from the following location by using a text editor:

<agent_dir>/bin/installation/

where <agent_dir> is the agent’s installation directory on the node.

2 Edit the changed policy names in this file. Add new policy names (within Template 
markup), if required.

3 Restart the agent.

4 Redeploy Exchange SPI instrumentation on the node.
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Data Collection on Virtual Servers

The Exchange SPI shows Exchange virtual servers in reports and graphs as though they were 
physical Exchange servers.You must deploy appropriate policies to a managed node to 
successfully show correct data for the node in reports and graphs. Follow the guidelines given 
below for deploying data collection policies on cluster nodes of  Microsoft Exchange Server 
2003/2000.

Microsoft Exchange Server 2003/2000

Run the Enable Message Tracking tool on all nodes in the cluster before deploying the EXSPI 
6.X Dc-TrackLog Data policy, so that the policy can generate tracking log reports. The tool 
must run on the physical nodes of a cluster where the Exchange virtual server is running.

Setting up End-to-End Message Ping on an Exchange Cluster

To configure End-to-End Message Ping in an Exchange 2003/2000 clusters, follow these steps:

1 Run the MBox Config tool on all nodes in the cluster. The tool must run on the physical 
nodes of a cluster where the Exchange virtual server is running. This is a necessary step 
for configuring and deploying End-to-End Message Ping. 

2 Run the End-to-End Configuration (wizard) tool to add the Exchange virtual server to the 
end-to-end configuration. Exchange virtual server names will appear in the Source Server 
and Destination Server fields. See Configuring Exchange SPI for Message Delivery SLAs 
on page 53.

Map View for Exchange Cluster Services

The Exchange SPI represents Exchange clusters in the map view. Map view creates one node 
for each virtual server in the cluster. Because the cluster is properly modeled in the service 
map, Exchange SPI instrumentation and Quick Start policies are auto-deployed to all 
managed Exchange cluster nodes.

Messages for the Exchange virtual server show up under the Exchange virtual server name in 
the maps.

For the Exchange Virtual server an EXSPI service discovery hosted-on hierarchy is created 
within a Clusters container. This allows messages to be sent to the hosted-on hierarchy. 

This same hierarchy is also created as virtual nodes under the Exchange Virtual Server. A 
dependency is created from each Virtual Exchange Server virtual node to its corresponding 
Cluster hosted-on node. Messages and status will then propagate to the correct Virtual 
Exchange Server virtual node.
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Figure 7  Service Map Illustrating Clustering Support 

When a fail-over happens, dependencies to the failed node will be removed and replaced with 
new dependencies to the newly active node..

When a failover happens, messages that occurred before the failover will not 
be propagated to the virtual node

For this mechanism to work EXSPI-6.0 Exchange Cluster Discovery Event 
Log policy must be deployed (normally auto-deployed) for Exchange 2000 
nodes.
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6 Additional Configuration for Microsoft 
Exchange Server 2007
The Exchange SPI enables you to customize the monitoring activity on Microsoft Exchange 
Server 2007 nodes. By default, the collectors on Microsoft Exchange Server 2007 nodes follow 
a pre-defined data collection mechanism. The SPI enables you to customize this definition to 
create new mechanisms to collect and store metric data. 

Data Collection Mechanism on Microsoft Exchange Server 2007

The default data collection mechanism on Microsoft Exchange Server 2007 is described in an 
XML file (spimetadata.xml). When you add a node for the first time, the default 
spimetadata.xml file is placed on the node. The collectors start collecting metric data 
according to this XML file. The Exchange SPI provides you with a utility (PowerShell 
collection configuration utility) to modify the default mechanism of data collection on 
Microsoft Exchange Server 2007 nodes. PowerShell collection configuration utility enables 
you to modify the spimetadata.xml file through its graphic user interface.

On a managed node, collectors collect metric data. If logging information is available, 
collectors log the collected data to a data store. Every collector follows a pre-defined 
mechanism to collect and log data, which is retrieved from the spimetadata.xml file. 

Collection is an element in the spimetadata.xml file that describes the complete data 
collection mechanism of a particular collector. Collection configuration consists of the 
following components or building blocks: 

• MetricSet — A metric is a measurement that defines a specific operational or 
performance characteristic of a system or an application. A MetricSet is a group of related 
metrics.

• OpCMsg  — An OpCMsg is an element of a collection that generates an alert message 
when a metric value does not match a preset value or range of values.

• OpCMon —  An OpCMon is an element of a collection that sends the collected metric 
data to a measurement threshold policy. The measurement threshold policy checks the 
data against some upper or lower threshold defined within the policy and sends alarm to 
the message browser.

• DataStore — A DataStore defines the way in which the collected data can be stored in 
the data store.

Collection Configurations

A collection configuration describes the complete workflow of a collector and defines the 
mechanism of metric data collection. It also defines how to store metric data. Every collection 
is associated with a scheduled task policy. When you invoke a scheduled task policy on a 
managed node, a collector retrieves the following information from a collection:

• The metric value to be collected 
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• The mechanism to send the collected data to analyzer for data analysis

• The mechanism to receive the analyzed data

• The mechanism to send the analyzed data to a DataStore (if required)

PowerShell Collection Configuration Utility

The Exchange SPI provides you with a utility (PowerShell collection configuration 
utility) to modify the default mechanism of data collection on Microsoft Exchange Server 
2007 nodes. PowerShell collection configuration utility enables you to modify the 
spimetadata.xml file through its graphic user interface. You can change existing collection 
definitions, or create new collection definition to monitor additional metric data. It enables 
you to perform the following tasks:

• View existing collection configurations

• Modify existing collection configurations

• Add a new MetricSet

• Add an OpcMsg

• Add an OpcMon

• Add a DataStore

• Add a new collection configuration

Refer to the Smart Plug-in for Microsoft Exchange Server Online Help for information on 
PowerShell collection configuration utility.

Adding or Modifying a Collection Configuration

To customize metric data collection mechanism on Microsoft Exchange Server 2007 nodes, you 
can modify an existing collection configuration present in the spimetadata.xml file, or you 
can add a new collection configuration. Using PowerShell collection configuration utility, you 
can customize the configuration, and save the change in the spimetadata.xml file. After 
making the change, you must place this updated spimetadata.xml file on managed nodes 
by deploying the SPIMetaData Versioning policy the nodes.

Task 1: Run the PowerShell Collection Configuration Utility Tool

The PowerShell Collection Configuration Utility tool launches the PowerShell collection 
configuration utility interface. To run it, follow these steps:

1 In the console tree, expand Tools → SPI for Exchange, and then click Exchange 2007.
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2 In the details pane, double-click PowerShell Collection Configuration Utility. The Select 
Server dialog box opens.

3 Select the OVO Windows Server option, and then click Load. The PowerShell collection 
configuration utility window opens.

Task 2: Add or Modify Elements of a Collection Configuration

You can modify the following components (building blocks) of a collection configuration or 
create new ones.

• MetricSet — Every default MetricSet corresponds to an Exchange PowerShell command 
(cmdlet). You can add additional MetricSets to the set of existing MetricSets and map 
those to available Exchange cmdlets. You can also add an available metric to a MetricSet.

• DataStore — You can modify the metric data logging mechanism by modifying an existing 
DataStore. PowerShell collection configuration utility enables you to add new definitions 
of logging metric data by creating a new DataStore.

• OpCMsg and OpCMon  — OpCMsgs and OpCMons describe the mechanism to trigger an 
error message when a metric value does not match with a preset value. Use PowerShell 
collection configuration utility to modify OpCMsgs/OpCMons if you want to:

— Change default error messages

— Change preset value

— Change severity level of OpCMsgs/OpCMons

Refer to the Smart Plug-in for Microsoft Exchange Server Online Help for detailed information 
on adding or modifying these components.

Task 3: Deploy the EXSPI-8.X SPIMetaData Versioning Policy on Nodes

After you make modifications in collection definitions, which are recorded in the 
spimetadata.xml file, you must deploy the file on the nodes of your interest. To achieve this, 
deploy the EXSPI-8.X SPIMetaData Versioning policy on the managed nodes on which you 
want to implement the modified data collection mechanism. 

While modifying default collection configurations or adding new collection configurations, if 
you change existing DataStores or add new DataStores, you must launch the Create Data 
Sources tool on the nodes on which you want the change to take effect. Launch the Create 
Data Source tool before you deploy the EXSPI-8.X SPIMetaData Versioning policy.
Additional Configuration for Microsoft Exchange Server 2007 75



To deploy the EXSPI-8.X SPIMetaData Versioning policy on managed nodes, follow these 
steps:

1 In the console tree, expand Policy groups → SPI for Exchange → Exchange 2007 → Manual 
Deploy Groups, and then click Collector Definition.

2 In the details pane, right-click EXSPI-8.X SPIMetaData Versioning, and then click All Tasks → 
Update to latest.

3 In the details pane, right-click EXSPI-8.X SPIMetaData Versioning, and then click All Tasks → 
Deploy on. The Deploy policies on dialog box opens.

4 Select the nodes on which you want to deploy the policy from the tree, and then click OK.

After you deploy the EXSPI-8.X SPIMetaData Versioning policy, the updated 
spimetadata.xml file is placed on the selected nodes. The Refresh Collector Definition 
policy updates the collection manager process with the modified collection mechanism 
described in the newly deployed spimetadata.xml file. 

The Refresh Collector Definition periodically runs on the node with an interval of 30 minutes. 
The new collection mechanism is not synchronized to the collection manager until the Refresh 
Collector Definition runs on the node. If you want the changes to take effect immediately after 
you deploy the SPIMetaData Versioning policy, launch the following tools in the given 
sequence on the nodes after deploying the SPIMetaData Versioning policy:

1 Stop ExData Collection Manager

2 Stop PowerShell Collector

3 Start PowerShell Collector

4 Start ExData Collection Manager

Using Additional Cmdlets

You can create customized cmdlets and use those cmdlets to monitor metric data on a 
managed node. You can create customized cmdlets to return additional metrics, and configure 
the SPI to monitor these additional metrics. Perform the following tasks to achieve this:

Task 1: Identify the Microsoft Exchange Server 2007 Node

Identify the Microsoft Exchange Server 2007 node on which you want to add customized 
cmdlets to observe additional metric data.

Task 2: Create Cmdlets

Create customized cmdlets on the identified nodes.

Task 3: Install Snap-ins

Install customized snap-ins for the newly created cmdlets on the nodes on which you have 
created new cmdlets.
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Task 4: Update the Exspi-exshell.psc1 File

To update the Exspi-exshell.psc1  file with the new snap-in information, follow these 
steps:

1 Open the Exspi-exshell.psc1 file by using a text editor from the location 
<Agent_Dir>/bin/instrumentation, where <Agent_Dir> is the install directory of 
agent on the node.

2 Add the following within the PSSnapin tag:

<PSSnapIn Name="new_snap-in_name" /> 
where new_snap-in_name is the name of newly added snap-in.

3 Save the file.

Task 5: Create New Collection Definitions for New Cmdlets

Use policy composer and create new collections with newly added cmdlets.

Task 6: Deploy the EXSPI-8.X SPIMetaData Versioning Policy on Nodes

Deploy the EXSPI-8.X SPIMetaData Versioning policy on the nodes on which you have 
created new cmdlets.
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7 Using Exchange SPI Policies, Reports, and 
Graphs
Exchange SPI policies enable you to simplify monitoring the performance and health of 
Microsoft Exchange Server. A policy contains a rule or a set of rules that automate the 
monitoring operation. The data collection mechanism of collectors on the managed nodes is 
governed by these policies. Policies can trigger alert signals in case of threshold violation. The 
SPI also enables you to generate reports and graphs to analyze metric data.

This chapter contains tables of Exchange SPI policies, reports and graphs, and outlines 
procedures for: 

• Deploying the various policy groups

• Generating Exchange SPI reports and graphs.

Using Exchange SPI Policies

Exchange SPI policies are classified in four broad groups — Exchange 5.5, Exchange 2000, 
Exchange 2003, and Exchange 2007. Each group contains policies specific to a particular 
Microsoft Exchange Server version. Refer to the general information on Exchange SPI policies 
listed below:

• Some policies in the SPI for Exchange policy groups require that particular software 
components or services be installed on Exchange server systems before the deployed 
policies will work.  

• Do not deploy Exchange SPI policies on a non-Exchange systems.

• Regarding policy names:

— Policies for only Microsoft Exchange Server 2007 are prefixed with EXSPI-8.X

— Policies for only Microsoft Exchange Server 2003 are prefixed with EXSPI-6.5

— Policies for only Microsoft Exchange Server 2000 are prefixed with EXSPI-6.0 

— Policies for Microsoft Exchange Server version 2000 and 2003 are prefixed with 
EXSPI-6.X 

— Policies for Microsoft Exchange Server version 5.5 are prefixed with EXSPI-5.5

• You can use the ovpmwutil tool to update account information (user name and password) 
in multiple policies. Refer to the Server Command Line Utilities section in the 
HP OpenView Operations for Windows Online Help.

Individual policy definitions are documented in the Exchange SPI online Help.

Policy Groups are located in the console tree under Policy Management → Policy Groups → SPI 
for Exchange and then the Exchange version.
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Exchange 2007 Policies

The SPI for Microsoft Exchange Server 2007 does not provide any auto deploy policies. You 
must manually deploy the available policies depending on your requirement.

Exchange 2007 
Manual Deploy 
Groups Policies

Availability • EXSPI-8.X Exchange 2007 Application Errors
• EXSPI-8.X Exchange 2007 Application Warnings
• EXSPI-8.X Exchange 2007 Application Info

Client Access 
Server

• Availability
— EXSPI-8.X Monitor Client Access Server Services

• IMAP4
— EXSPI-8.X Monitor Check IMAP4 Max Connection
— EXSPI-8.X Dc-IMAP4 Performance
— EXSPI-8.X IMAP4 Failed Connection Rate
— EXSPI-8.X Monitor Check IMAP4 Max Connections from 

Single IP
— EXSPI-8.X IMAP4 Connections
— EXSPI-8.X Get IMAP4 Settings
— EXSPI-8.X Monitor Check IMAP4 Max Connections per User
— EXSPI-8.X IMAP4 Rejected Connection Rate

• Outlook Anywhere
— EXSPI-8.X Check Outlook Anywhere Enabled
— EXSPI-8.X Check Outlook Anywhere Not Enabled

• POP3
— EXSPI-8.X POP3 Failed Connection Rate
— EXSPI-8.X POP3 Connections
— EXSPI-8.X POP3 Rejected Connection Rate
— EXSPI-8.X Get POP3 Settings
— EXSPI-8.X Dc-POP3 Performance
— EXSPI-8.X Monitor Check POP3 Max Connections from 

Single IP
— EXSPI-8.X Monitor Check POP3 Max Connection
— EXSPI-8.X Monitor Check Pop3 Max Connections per User

Collector Definition • EXSPI-8.X SPIMetaData Versioning
• Check Collector Server
• Check Collection Manager
• Refresh Collection Definition

Discovery Exchange 2007 Discovery
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Edge Server • EXSPI-8.X Edge Get Queue Data
• EXSPI-8.X Edge Check Tracking Log Settings
• EXSPI-8.X Edge Get Configuration of the Transport Agent
• Availability

— EXSPI-8.X Monitor Edge Server Services
• SMTP

— EXSPI-8.X Edge Dc-SMTP Performance for Inbound 
Connections

— EXSPI-8.X Edge Dc-SMTP Performance for Outbound 
Connections

ExBPA Integration • EXSPI-8.X Forward ExBPA Event Log Errors
• EXSPI-8.X ExBPA Integration

Hub Transport 
Server

• EXSPI-8.X Get Queue Data
• EXSPI-8.X Check Tracking Log Settings
• EXSPI-8.X Get Configuration of the Transport Agent
• Availability

— EXSPI-8.X Monitor Hub Transport Server Services
• SMTP

— EXSPI-8.X Edge Dc-SMTP Performance for Inbound 
Connections

— EXSPI-8.X Edge Dc-SMTP Performance for Outbound 
Connections

Exchange 2007 
Manual Deploy 
Groups Policies
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Mailbox Server • Availability
— EXSPI-8.X Monitor Mailbox Server Services

• High Availability
— Replication Monitoring

– EXSPI-8.X ReplicationCopyQueueLength

– EXSPI-8.X Replication Warnings in Application Event 
Log

– EXSPI-8.X Replication Errors in Application Event Log

– EXSPI-8.X Dc Replication Summary

– EXSPI-8.X ReplicationReplayQueueLength

– EXSPI-8.X Check Replication Service

• Mailbox
— EXSPI-8.X MailBoxItemCount
— EXSPI-8.X  IS Mailbox Average Delivery Time
— EXSPI-8.X  IS Mailbox Receive Queue Length
— EXSPI-8.X  Dc-IS Mailbox Performance
— EXSPI-8.X Check Circular Logging Enabled
— EXSPI-8.X Get Mailbox Details
— EXSPI-8.X Check If Circular Logging Disabled

• MAPI
— EXSPI-8.X Information Store RPC Operations
— EXSPI-8.X Test Mapi Connectivity
— EXSPI-8.X Information Store RPC Averaged Latency
— EXSPI-8.X Information Store RPC Requests

• Outlook Performance
— EXSPI-8.X Dc-Outlook Client
— EXSPI-8.X Outlook Client RPC Failure Rate
— EXSPI-8.X Outlook Client Latency

• Performance
— EXSPI-8.X Information Store Heap Memory Errors
— EXSPI-8.X Information Store VM Large Block Bytes
— EXSPI-8.X Information Store Db Log Record Stalls per sec
— EXSPI-8.X Information Store Performance
— EXSPI-8.X Information Store Additional Heaps
— EXSPI-8.X Information Store User Count
— EXSPI-8.X Information Store Db Cache Size
— EXSPI-8.X Information Store Db Log Threads Waiting
— EXSPI-8.X Information Store Memory Errors
— EXSPI-8.X Information Store VM Largest Block

Exchange 2007 
Manual Deploy 
Groups Policies
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Exchange 2003 policies

Exchange 2003 Auto Deploy policies

   

Mailbox Server
(Cont.)

— EXSPI-8.X Information Store VM 16MB Blocks
— EXSPI-8.X Information Store Db Log Writes per sec

• Public Folder
— EXSPI-8.X  PublicFolderItemCount
— EXSPI-8.X  Public Replication Queue Length
— EXSPI-8.X  Get Public Folder Details
— EXSPI-8.X  IS Public Average Delivery Time
— EXSPI-8.X  IS Public  Receive Queue Length
— EXSPI-8.X  Dc-IS Public Folder Performance

Unified Messaging 
Server

— EXSPI-8.X GetUM IPGateway Details
— EXSPI-8.X Get UMHuntGroup Details 
— EXSPI-8.X Get UMMailbox Pin Details
— EXSPI-8.X Get UMMailbox Policy Details
— EXSPI-8.X Get UMServer Details
— EXSPI-8.X Get Unified Messaging Mailbox Details

• Availability
— EXSPI-8.X Monitor Unified Messaging Server Services

Exchange 2007 
Manual Deploy 
Groups Policies

Exchange 2003 
Auto Deploy Groups Policies

Availability EXSPI-6.X Queue State
EXSPI-6.X Connector State
EXSPI-6.X Exchange System Errors
EXSPI-6.X Link State
EXSPI-6.X Exchange Services
EXSPI-6.X Process Monitor
EXSPI-6.X Exchange Application Errors
EXSPI-6.X Inactive Process Monitor
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Client Accessibility ActiveSync
             EXSPI-6.5 ActiveSync AD Requests
             EXSPI-6.5 ActiveSync Mailbox Connection Requests
             EXSPI-6.5 ActiveSync Mailbox pending requests
             EXSPI-6.5 ActiveSync Users
             EXSPI-6.5 Dc-ActiveSync
             EXSPI-6.5 Dc-ActiveSyncNotify
OMA
             EXSPI-6.5 OMA Response time
             EXSPI-6.5 Dc-OMA
             EXSPI-6.5 OMA Application Event Errors
IMAP4
             EXSPI-6.X IMAP4 Failed Connection Rate
             EXSPI-6.X IMAP4 Rejected Connection Rate
             EXSPI-6.X IMAP4 Connections
             EXSPI-6.X Dc-IMAP4 Performance
             EXSPI-6.X IMAP4 Port Response
MAPI
             EXSPI-6.X Information Store RPC Requests
             EXSPI-6.X Information Store RPC Operations
             EXSPI-6.X Information Store RPC Averaged Latency
Outlook 2003
             EXSPI-6.5 Dc-Outlook Client
             EXSPI-6.5 Outlook Client Latency
             EXSPI-6.5 Outlook Client RPC Failure Rate

Client Accessibility 
(cont)

OWA
Front End:
             EXSPI-6.X OWA Current Connections
             EXSPI-6.X Dc-OWA Front End
             EXSPI-6.X HTTP Port Response
Back End:
             EXSPI-6.X Dc-OWA Back End
POP3
             EXSPI-6.X POP3 Failed Connection Rate
             EXSPI-6.X POP3 Rejected Connection Rate
             EXSPI-6.X POP3 Connections
             EXSPI-6.X Dc-POP3 Performance
             EXSPI-6.X POP3 Port Response

Cluster EXSPI-6.X Exchange Cluster Discovery SysLog
EXSPI-6.X Cluster Connection Limits
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Directory EXSPI-6.X DSAccess Cache Hit-Miss Ratio
EXSPI-6.X Dc-DSAccess Performance
EXSPI-6.X DSAccess Application Errors

Information Store Epoxy
             EXSPI-6.5 Epoxy Store Out Queue Length
             EXSPI-6.5 Epoxy Client Out Queue Length
Full Text Index
             EXSPI-6.X Dc-Full Text Index
             EXSPI-6.X-0074
Mailbox
             EXSPI-6.X IS Mailbox Average Delivery Time
             EXSPI-6.X IS Mailbox Receive Queue Length
             EXSPI-6.X IS Mailbox Send Queue Length
             EXSPI-6.X Database Mounted Search
             EXSPI-6.X 1h-Mailbox Space Usage
             EXSPI-6.X Dc-Mailbox IS Sum. Data
             EXSPI-6.X Dc-Mailbox Data
             EXSPI-6.X Dc-IS Mailbox Performance
             EXSPI-6.X Database Mounted Check
             EXSPI-6.X-0070
Performance
             EXSPI-6.X Information Store Db Cache Size
             EXSPI-6.X Information Store Db Log Threads Waiting
             EXSPI-6.X Information Store Db Log Record Stalls per sec
             EXSPI-6.X Information Store Db Log Writes per sec
             EXSPI-6.X Dc-Information Store Performance
             EXSPI-6.X Information Store User Count
             EXSPI-6.X Information Store VM Largest Block
             EXSPI-6.X Information Store VM 16MB Blocks
             EXSPI-6.X Information Store VM Large Block Bytes
             EXSPI-6.X Check Memory Configuration
             EXSPI-6.5 Information Store Additional Heaps
             EXSPI-6.5 Information Store Memory Errors
             EXSPI-6.5 Information Store Heap Memory Errors

Exchange 2003 
Auto Deploy Groups Policies
86 Chapter 7



Information Store 
(cont)

Public Folder
             EXSPI-6.X IS Public Replication Queue Length
             EXSPI-6.X 1h-Public Folder Space Usage
             EXSPI-6.X Dc-IS Public Folder Performance
             EXSPI-6.X Database Mounted Search
             EXSPI-6.X Database Mounted Check
             EXSPI-6.X Dc-Public Folder Data
             EXSPI-6.X IS Public Receive Queue Length
             EXSPI-6.X Dc-Public IS Sum. Data
             EXSPI-6.X IS Public Send Queue Length
             EXSPI-6.X IS Public Average Delivery Time
             EXSPI-6.X-0072
Transaction Log
             EXSPI-6.X-0004
             EXSPI-6.X-0008
             EXSPI-6.X Transaction Log BackUp Check
             EXSPI-6.X Transaction Log Space Usage
Virus Scan
             EXSPI-6.X Virus Scan Messages Quarantined per Sec
             EXSPI-6.X Virus Scan Files Cleaned per Sec
            EXSPI-6.X Virus Scan Queue Length
             EXSPI-6.X Virus Scan Files Quarantined per sec
             EXSPI-6.X Virus Scan Messages Cleaned per Sec
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Messaging cc:Mail Connector
             EXSPI-6.X 1h-ccMail Connector
             EXSPI-6.X-0091
             EXSPI-6.X 5m-ccMail Connector
             EXSPI-6.X-0093
             EXSPI-6.X-0092
             EXSPI-6.X-0090
Lotus Notes Connector
             EXSPI-6.X Lotus Notes Process Monitor
             EXSPI-6.X-0094
             EXSPI-6.X 1h-Lotus Notes Connector
             EXSPI-6.X-0095
             EXSPI-6.X-0096
             EXSPI-6.X-0096
             EXSPI-6.X 5m-Lotus Notes Connector
MTA
             EXSPI-6.X MTA Work Queue Length
             EXSPI-6.X Dc-MTA Performance
             EXSPI-6.X MTA Rejected Inbound Messages
             EXSPI-6.X MTA Connection Queue Lengths
             EXSPI-6.X MTA Failed Outbound Associations
             EXSPI-6.X MTA Failed Conversions
             EXSPI-6.X MTA Message Delay
             EXSPI-6.X MTA Connection Message Delay
             EXSPI-6.X MTA Rejected Inbound Associations
             EXSPI-6.X Dc-X.400 Service MTA Queue
             EXSPI-6.X-0075
NNTP
             EXSPI-6.X 1h-NNTP
             EXSPI-6.X-0058
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Messaging (cont) SMTP
             EXSPI-6.X SMTP Messages Pending Routing
             EXSPI-6.X SMTP Categorizer Queue Length
             EXSPI-6.X SMTP Local Queue Length
             EXSPI-6.X SMTP Local Retry Queue Length
             EXSPI-6.X Dc-SMTP Server Performance
             EXSPI-6.X Dc-SMTP Queues
             EXSPI-6.X SMTP NDR Percentage
             EXSPI-6.X SMTP Outbound Connections Refused
             EXSPI-6.X SMTP Remote Queue Length
             EXSPI-6.X SMTP Remote Retry Queue Length
             EXSPI-6.X Dc-SMTP Virtual Server Storage
             EXSPI-6.X-0082
             EXSPI-6.X-0083
             EXSPI-6.X-0084
             EXSPI-6.X-0085
             EXSPI-6.X-0086
             EXSPI-6.X-0087
             EXSPI-6.X SMTP Port Response
Tracking Log
             EXSPI-6.X Dc-TrackLog Data
             EXSPI-6.X Dc-TrackLog SLA Delivery
             EXSPI-6.X Dc-Message Tracking Log Space Usage
             EXSPI-6.X-0076

ovo Exchange SPI 
core

Data Collection
             EXSPI-6.X exspi Agent Configuration
             EXSPI-6.X Messages
Exchange Discovery
             EXSPI-6.X Check Discovery
             EXSPI-6.X Exchange Service Discovery
             EXSPI-6.X Exchange Cluster Discovery SysLog
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Exchange 2003 Manual Deploy policies

Exchange 2003 
Manual Deploy 
Groups Policies

Site Replication 
Service

           EXSPI-6.X SRS Process Monitor
           EXSPI-6.X SRS Service
           EXSPI-6.X-0112
           EXSPI-6.X SRS Pending Synchronizations
           EXSPI-6.X SRS Data Space Usage
           EXSPI-6.X SRS Remaining Updates
           EXSPI-6.X-0113

Active Directory 
Connector Server

           EXSPI-6.X ADC Process Monitor
           EXSPI-6.X ADC Service
           EXSPI-6.X ADC Import Failure Rate
           EXSPI-6.X ADC Operation Failure Rate

Exchange Server
 

Availability
             EXSPI-6.X Server State
             EXSPI-6.X Exchange Application Information
             EXSPI-6.X Exchange System Information
             EXSPI-6.X Exchange Application Warnings
             EXSPI-6.X Exchange System Warnings
Transaction Log
             EXSPI-6.X-0005
             EXSPI-6.X-0006
             EXSPI-6.X Transaction Log Storage Use
Message Delivery
             EXSPI-6.X End to End Message Ping
Client Accessibility
             EXSPI-6.X Client Message Read
             EXSPI-6.X Client MAPI Logon
             EXSPI-6.X Client Message Send
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Exchange 2000 Policies

Exchange 2000 Auto Deploy Policies

    

Exchange 2000
Auto Deploy Groups Policies

Availability EXSPI-6.X Queue State
EXSPI-6.X Connector State
EXSPI-6.X Exchange System Errors
EXSPI-6.X Link State
EXSPI-6.X Exchange Services
EXSPI-6.X Process Monitor
EXSPI-6.X Exchange Application Errors
EXSPI-6.X Inactive Process Monitor

Client Accessibility IMAP4
             EXSPI-6.X IMAP4 Failed Connection Rate
             EXSPI-6.X IMAP4 Rejected Connection Rate
             EXSPI-6.X IMAP4 Connections
             EXSPI-6.X Dc-IMAP4 Performance
             EXSPI-6.X IMAP4 Port Response
MAPI
             EXSPI-6.X Information Store RPC Requests
             EXSPI-6.X Information Store RPC Operations
             EXSPI-6.X Information Store RPC Averaged Latency
OWA
Front End:
             EXSPI-6.X OWA Current Connections
             EXSPI-6.X Dc-OWA Front End
             EXSPI-6.X HTTP Port Response
Back End:
             EXSPI-6.X Dc-OWA Back End
POP3
             EXSPI-6.X POP3 Failed Connection Rate
             EXSPI-6.X POP3 Rejected Connection Rate
             EXSPI-6.X POP3 Connections
             EXSPI-6.X Dc-POP3 Performance
             EXSPI-6.X POP3 Port Response

Cluster EXSPI-6.X Exchange Cluster Discovery SysLog
EXSPI-6.0 Exchange Cluster Discovery AppLog
EXSPI-6.X Cluster Connection Limits
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Directory EXSPI-6.X DSAccess Cache Hit-Miss Ratio
EXSPI-6.X Dc-DSAccess Performance
EXSPI-6.X DSAccess Application Errors

Information Store Epoxy
             EXSPI-6.0 Epoxy Store Out Queue Length
             EXSPI-6.0 Epoxy Client Out Queue Length
Full Text Index
             EXSPI-6.X Dc-Full Text Index
             EXSPI-6.X-0074
Mailbox
             EXSPI-6.X IS Mailbox Average Delivery Time
             EXSPI-6.X IS Mailbox Receive Queue Length
             EXSPI-6.X IS Mailbox Send Queue Length
             EXSPI-6.X Database Mounted Search
             EXSPI-6.X 1h-Mailbox Space Usage
             EXSPI-6.X Dc-Mailbox IS Sum. Data
             EXSPI-6.X Dc-Mailbox Data
             EXSPI-6.X Dc-IS Mailbox Performance
             EXSPI-6.0 IS Mailbox Average Local Delivery Time
             EXSPI-6.X Database Mounted Check
             EXSPI-6.X-0070
Performance
             EXSPI-6.X Information Store Db Cache Size
             EXSPI-6.X Information Store Db Log Threads Waiting
             EXSPI-6.X Information Store Db Log Record Stalls per sec
             EXSPI-6.X Information Store Db Log Writes per sec
             EXSPI-6.X Dc-Information Store Performance
             EXSPI-6.X Information Store User Count
             EXSPI-6.X Information Store VM Largest Block
             EXSPI-6.X Information Store VM 16MB Blocks
             EXSPI-6.X Information Store VM Large Block Bytes
             EXSPI-6.X Check Memory Configuration

Exchange 2000
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Information Store 
(cont)

Public Folder
             EXSPI-6.X IS Public Replication Queue Length
             EXSPI-6.X 1h-Public Folder Space Usage
             EXSPI-6.0 IS Public Average Local Delivery Time
             EXSPI-6.X Database Mounted Search
             EXSPI-6.X Database Mounted Check
             EXSPI-6.X Dc-Public Folder Data
             EXSPI-6.X IS Public Receive Queue Length
             EXSPI-6.X Dc-Public IS Sum. Data
             EXSPI-6.X Dc-IS Public Folder Performance
             EXSPI-6.X IS Public Send Queue Length
             EXSPI-6.X IS Public Average Delivery Time
             EXSPI-6.X-0072
Transaction Log
             EXSPI-6.X-0004
             EXSPI-6.X-0008
             EXSPI-6.X Transaction Log BackUp Check
             EXSPI-6.X Transaction Log Space Usage
Virus Scan
             EXSPI-6.X Virus Scan Messages Quarantined per Sec
             EXSPI-6.X Virus Scan Files Cleaned per Sec
            EXSPI-6.X Virus Scan Queue Length
             EXSPI-6.X Virus Scan Files Quarantined per sec
             EXSPI-6.X Virus Scan Messages Cleaned per Sec
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Messaging cc:Mail Connector
             EXSPI-6.X 1h-ccMail Connector
             EXSPI-6.X-0091
             EXSPI-6.X 5m-ccMail Connector
             EXSPI-6.X-0093
             EXSPI-6.X-0092
             EXSPI-6.X-0090
Lotus Notes Connector
             EXSPI-6.X Lotus Notes Process Monitor
             EXSPI-6.X-0094
             EXSPI-6.X 1h-Lotus Notes Connector
             EXSPI-6.X-0095
             EXSPI-6.X-0096
             EXSPI-6.X-0097
             EXSPI-6.X 5m-Lotus Notes Connector
MTA
             EXSPI-6.X MTA Work Queue Length
             EXSPI-6.X Dc-MTA Performance
             EXSPI-6.X MTA Rejected Inbound Messages
             EXSPI-6.X MTA Connection Queue Lengths
             EXSPI-6.X MTA Failed Outbound Associations
             EXSPI-6.X MTA Failed Conversions
             EXSPI-6.X MTA Message Delay
             EXSPI-6.X MTA Connection Message Delay
             EXSPI-6.X MTA Rejected Inbound Associations
             EXSPI-6.X Dc-X.400 Service MTA Queue
             EXSPI-6.X-0075
NNTP
             EXSPI-6.X 1h-NNTP
             EXSPI-6.X-0058
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Messaging (cont) SMTP
             EXSPI-6.X SMTP Messages Pending Routing
             EXSPI-6.X SMTP Categorizer Queue Length
             EXSPI-6.X SMTP Local Queue Length
             EXSPI-6.X SMTP Local Retry Queue Length
             EXSPI-6.X Dc-SMTP Server Performance
             EXSPI-6.X Dc-SMTP Queues
             EXSPI-6.X SMTP NDR Percentage
             EXSPI-6.X SMTP Outbound Connections Refused
             EXSPI-6.X SMTP Remote Queue Length
             EXSPI-6.X SMTP Remote Retry Queue Length
             EXSPI-6.X Dc-SMTP Virtual Server Storage
             EXSPI-6.X-0082
             EXSPI-6.X-0083
             EXSPI-6.X-0084
             EXSPI-6.X-0085
             EXSPI-6.X-0086
             EXSPI-6.X-0087
             EXSPI-6.X SMTP Port Response
Tracking Log
             EXSPI-6.X Dc-TrackLog Data
             EXSPI-6.X Dc-TrackLog SLA Delivery
             EXSPI-6.X Dc-Message Tracking Log Space Usage
             EXSPI-6.X-0076
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Optional Exchange 
Server Roles

EXSPI Chat Service
             EXSPI-6.0-0836
             EXSPI-6.0-0835
             EXSPI-6.0 15m-Chat
             EXSPI-6.0-0834
             EXSPI-6.0-0833
             EXSPI-6.0-0831
             EXSPI-6.0-0830
             EXSPI-6.0 Dc-Chat Service Clients and Channels
EXSPI Conferencing Service
       EXSPI Conference Server
              EXSPI-6.0-0801
              EXSPI-6.0 10m-Conf
              EXSPI-6.0 Dc-ConfTrends
              EXSPI-6.0-0800
              EXSPI-6.0-0802
       EXSPI Conferencing Bridge
               EXSPI-6.0-0805
               EXSPI-6.0 10m-ConfBridge
               EXSPI-6.0-0807
               EXSPI-6.0-0806
EXSPI MCU Server
               EXSPI-6.0-0803
               EXSPI-6.0 10m-MCU
               EXSPI-6.0 Dc-MCU
               EXSPI-6.0-0804
EXSPI Instant Messaging
             EXSPI-6.0-0842
             EXSPI-6.0-0846
             EXSPI-6.0-0845
             EXSPI-6.0 Dc-Instant Messaging Enabled Users
             EXSPI-6.0-0841

ovo Exchange SPI 
core

Data Collection
             EXSPI-6.X exspi Agent Configuration
             EXSPI-6.X Messages
Exchange Discovery
             EXSPI-6.X Check Discovery
             EXSPI-6.X Exchange Service Discovery
             EXSPI-6.X Exchange Cluster Discovery SysLog
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Exchange 2000 Manual Deploy policies

Exchange 2000 
Manual Deploy 
Groups Policies

Site Replication 
Service

           EXSPI-6.X SRS Process Monitor
           EXSPI-6.X SRS Service
           EXSPI-6.X-0112
           EXSPI-6.X SRS Pending Synchronizations
           EXSPI-6.X SRS Data Space Usage
           EXSPI-6.X SRS Remaining Updates
           EXSPI-6.X-0113

Active Directory 
Connector Server

           EXSPI-6.X ADC Process Monitor
           EXSPI-6.X ADC Service
           EXSPI-6.X ADC Import Failure Rate
           EXSPI-6.X ADC Operation Failure Rate

Exchange Server
 

Availability
             EXSPI-6.X Server State
             EXSPI-6.X Exchange Application Information
             EXSPI-6.X Exchange System Information
             EXSPI-6.X Exchange Application Warnings
             EXSPI-6.X Exchange System Warnings
Transaction Log
             EXSPI-6.X-0005
             EXSPI-6.X-0006
             EXSPI-6.X Transaction Log Storage Use
Message Delivery
             EXSPI-6.X End to End Message Ping
Client Accessibility
             EXSPI-6.X Client Message Read
             EXSPI-6.X Client MAPI Logon
             EXSPI-6.X Client Message Send
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Manual Deployment of Exchange 2000 and 2003 Policies

By default, groups of Exchange SPI policies deploy automatically when relevant applications 
or services are discovered on managed nodes. The setting to automatically deploy policies 
when services are discovered can be turned off, and each group of policies can be deployed 
manually. 

If manual deployment of policies is desired, use the Recommended Policy deployment tables in 
the Exchange SPI online help to determine which policy groups should be deployed to manage 
an Exchange server.

Perform the following steps to deploy policies manually:

1 Select the desired policies. 

2 Right-click, and then click All Tasks → Deploy on..... 

3 Select the nodes on which to deploy the policies. 

4 Click Launch...

Manual Deploy Policy Groups

There is also a Manual Deploy folder containing policies, located under Policy Management 
Policy Groups SPI for Exchange, and the relevant Exchange version. These folders contain 
policies requiring additional configuration or special circumstances for deployment. 
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Exchange 5.5 Policies

Policy Group Prerequisites for Exchange 5.5  

Policy Group/ Subgroup Required Service
Required Manual 
Configuration

EXSPI Discovery N/A • Create MSXSPI service 
account with correct 
permissions

• Modify the policy to include 
service account and password.

EXSPI Quick Start N/A N/A

EXSPI Add-Ons
EXSPI cc:Mail Connector cc:Mail Connector N/A

EXSPI Internet Mail 
Services

Internet Mail Service 
(IMS)

N/A

EXSPI Lotus Notes 
Connector

Lotus Notes Connector N/A

EXSPI News Service N/A N/A

EXSPI Advanced
EXSPI End-to-End Message 
Ping 

N/A • Create MSXSPI service 
account with correct 
permissions

• Create mailbox using MBOX 
Config tool (needs service 
account name and password)

• Configure EXSPI End-to-End 
Message Ping policy to set up 
server pairs

• Modify the policy to include 
user name and password

EXSPI Event Log Warnings 
& Information

N/A N/A

EXSPI Reporter Collection N/A • Create MSXSPI service 
account and password

• Modify policies to include user 
name and password
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Policy Group Descriptions for Exchange 5.5

Quick Start Policies for Exchange 5.5

Policy Subgroup Description

EXSPI Directory Service Executes alarm metrics for problems detected in the Microsoft 
Exchange Directory service.

EXSPI Event Log Errors Monitors all errors (type = Error) in the Windows System Log.

EXSPI General Data 
Collection

Contains all standard data collection policies used to feed data 
into the data collector. The collected data can be graphed or used 
to generate reports.

EXSPI Information 
Store

Executes alarm metrics for problems detected in the Exchange 
Information Store service.

EXSPI Internal Errors Open Message Interface policy for trapping EXSPI errors.

EXSPI Message 
Transfer Agent

Executes alarm metrics for problems detected in the Microsoft 
MTA service.

EXSPI Services and 
Processes

Monitors the availability of key Exchange services and processes.

EXSPI Transaction Log Monitors the size in MB of the Exchange transaction logfiles as 
well as the disk space used by the files. When size increases or 
available disk space decreases to specific defined values, 
messages with warnings appear in the message browser.
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Add-Ons Policies for Exchange 5.5

Advanced Policies for Exchange 5.5

Policy Subgroup Description

EXSPI cc:Mail 
Connector

Executes alarm according to cc:Mail Connector metrics. Deploy on 
all Exchange servers containing the cc:Mail Connector.

EXSPI Internet Mail 
Services

Executes alarm metrics for the problems detected in Exchange 
Internet Mail service. Deploy on all Exchange servers containing 
IMS.

EXSPI Lotus Notes 
Connector

Executes alarms for Lotus Notes Connector metrics. Deploy on all 
Exchange servers containing the Lotus Notes Connector.

EXSPI News Service Executes alarm metrics for problems detected in the Exchange 
News service. Deploy on all Exchange 5.5 servers containing the 
Exchange News service.

Policy Subgroup Description

EXSPI End-to-End 
Message Ping 

Alarms on AND collects data for the End-to-End Message Ping 
policy

EXSPI Event Log 
Warnings/Information

Monitors all warnings and information messages in the Windows 
System Log. Is not typically deployed.

EXSPI Reporter 
Collection

Feeds data into the OpenView data collector for use by OpenView 
reporter.
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Using Exchange 5.5 Reports and Graphs

Data Collection for Reports and Graphs

To collect data for Exchange 5.5 reports and graphs, the data collection schedule policies for 
any particular service need to be deployed.

Configuring and Deploying Reporter Collection Policies

The Exchange SPI Reporter Collection policies need to be deployed to any Exchange server for 
which you wish reports. 

 

Task 1: Create Mailboxes

See the procedure Create Mailboxes on page 58.

Task 2: Modify the EXSPI Reporter Collection Policies to Include the Service Account User Name and 
Password

For Exchange 5.5 servers you need to edit each of the EXSPI Reporter Collection policies in 
the EXSPI Advanced policy group by adding the service account user name and password, so 
that Exchange server system data is accessible. The EXSPI General Data Collector policies in 
the EXSPI Quick Start policy group do not need modification.

1 Open the OVO console and expand the Policy Management folder.
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2 In the left pane select Policy groups → SPI for Exchange → Exchange 5.5 →EXSPI Advanced 
→ EXSPI Reporter Collection policy group.

3 In the right pane right-click a Reporter Collection policy and select All Tasks > Edit.

4 In the dialog that appears, check the As User radio button, enter the name of the service 
account, check Specify Password and enter the service account password.

5 Click Save and Close.

6 Repeat these steps for each Reporter Collection policy in the group.

Task 3: Deploy Reporter Collection Policies

1 In the OVO Manager console expand the Policy management → Policy groups folders to 
view policy groups.

2 Open SPI for Exchange → Exchange 5.5 → EXSPI Advanced to view the policy groups in the 
EXSPI Advanced folder.

3 In the EXSPI Advanced folder double-click the Reporter Collection policy sub-group and 
see the individual policies in the details pane. 

4 Select the Dc-Exchange Info policy, right-click and select All Tasks → Deploy on, check all 
the nodes and click OK. 

Other Reporter policies are deployed to servers depending on whether they host mailboxes 
or public folders. 

5 For servers which host mailboxes, select the Dc-TrackLog Data, Dc-Private IS Sum Data, 
and Dc-Mailbox Data policies in the details pane, right-click and select All Tasks → Deploy 
on, then select all the servers which host mailboxes and click OK. 

6 For servers which host public folders, select the Dc-Public Folder Data and Dc-Public IS 
Sum Data policies in the details pane, right-click and select All Tasks → Deploy on, then 
select all the servers which host public folders and click OK.

Task 4: Enabling Message Tracking 

Exchange provides a message-tracking facility that stores processed message information in a 
log file. This information, which includes sender address, recipient addresses, and message 
size, is collected by the EXSPI-5.5 Dc-TrackLog Data collection policy. This policy must be 
deployed to all appropriate managed nodes. 

Before deploying EXSPI 5.5 Dc-TrackLog Data collection policy you need to enable message 
tracking on your Exchange servers.

1 Select Start → Programs → Microsoft Exchange → Microsoft Exchange Administrator.

2 Expand the site level and Configuration to view selections beneath it.

3 In the details pane, double-click Information Store Site Configuration.

4 In the Information Store Site Configuration Properties dialog, check Enable message 
tracking, and then select OK.
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5 Repeat steps 3 and 4 for MTA Site Configuration.

     

6 In the left pane, select Connections.

If the Internet Mail Service connector does not exist, skip the following steps.
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7 In the right pane, select Internet Mail Service, check the Enable message tracking checkbox, 
and then click OK.

Time Interval before Generation of Reports

Exchange SPI reports are not available until data has been gathered to the management 
server from the managed nodes. This occurs each night, so at least one day of activity is 
needed for the reports to populate. Where a report type requires data from a Sat/Sun 
collection, those reports require a weekend prior to generation.

The SPI for Exchange Reports folder is not be created until data is collected on nodes and the 
Service Reporter consolidation process has run, which is usually 24 hours after a node 
becomes managed.   

To display a report, select the desired report, right click, and then select Show report.

Exchange SPI Reports

Reports enable you to analyze the data collected by the SPI. You can use HP OpenView 
Reporter in conjunction with OVO to generate reports. After the OVO agent collects metric 
data from the managed nodes, HP OpenView Reporter can create web-based reports for the 
collected data.

Exchange 2007 Reports

To view reports for Microsoft Exchange Server 2007, expand Reports and Graphs → Reports → 
SPI for Exchange 2007 in the console tree.

The SPI for Microsoft Exchange Server provides the following reports:

• Exchange 2007 Mailbox Details by Server — This report contains information about 
mailboxes on the Mailbox Server. This report displays information sorted by disk space 
usage and grouped by storage group and database.

• Exchange 2007 Top 100 Mailboxes — This report lists the top 100 mailboxes by disk space 
usage across all Exchange 2007 Mailbox Servers.

• Exchange 2007 Server Inactive Mailboxes by Server — This report lists the mailboxes 
that were not used to send mails in 20, 40 and 60 or more days and the number of days for 
which the mailboxes were not used.

• Exchange 2007 Mailbox Store Message Trends by Server — This report contains 
summary and detailed  trend graphs showing Mailbox Store message volumes.  

• Exchange 2007 Public Folder Messaging Trends by Server — This report contains 
summary and detail trend graphs showing Public Folder Store message volumes.

The SPI for Exchange Reports and Graphs folder is not created until data is collected on 
nodes and the Service Reporter consolidation process has run. Out of the box, the Reporter 
Data consolidation process (gathercoda.exe) is scheduled to run each day shortly after 
midnight.
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• Exchange 2007 Users and Connections by Server — This report provides a graph of the 
average number of users and connections counts for hours of the day over a given time 
period.

• Exchange 2007 POP3 Connections by Server — This report provides a graph of the 
average POP3 connection counts for hours of the day over a given time period.

• Exchange 2007 IMAP4 Connections by Server — This report provides a graph of the 
average IMAP4 connection counts for hours of the day for a given time period.

• Exchange 2007 SMTP Receive Messaging Trends by Server — This report provides a 
graphs showing the volume of simple mail transport protocol (SMTP) messages received 
by the receive connectors on transport servers.

• Exchange 2007 SMTP Send Messaging Trends by Server — This report contains trend 
graphs showing the volume of simple mail transport protocol (SMTP) messages sent by 
the send connectors on transport servers.

Exchange 2003 Reports

Exchange SPI reports for Exchange 2003 are located on the OVO console under Reports and 
Graphs → Reports → SPI for Exchange 2000, in the following groups:

Client Access 

Exchange 2003 ActiveSync Usage 

Exchange 2003 ActiveSync Notifications 

Exchange 2003 and 2000 IMAP4 Connections

Exchange 2003 and 2000 MAPI Logon SLA 

Exchange 2003 and 2000 Message Read SLA 

Exchange 2003 and 2000 Message Send SLA 

Exchange 2003 and 2000 OWA Authentications

Exchange 2003 and 2000 OWA Connections

Exchange 2003 and 2000 OWA Usage 

Exchange 2003 OMA Sync Usage 

Exchange 2003 and 2000 POP3 Connections

Exchange 2003 and 2000 Messaging Ports 

Exchange Server 

Exchange 2000 and 2003 System Information Summary 

Information Store

Exchange 2003 and 2000 Full Text Indexing Stats   

Exchange 2003 and 2000 IS Users and Connections 

Exchange 2003 and 2000 Transaction Log Stats   

Mailbox Store 

Exchange 2003 and 2000 Inactive Mailboxes 
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Exchange 2003 and 2000 Mailbox Details 

Exchange 2003 and 2000 Mailbox Store Stats

Exchange 2003 and 2000 Mailbox Summary 

Exchange 2003 and 2000 Mailbox Store Msg Trends   

Exchange 2003 and 2000 Mailbox Usage Trends 

Exchange 2003 and 2000 Top 100 Mailboxes 

Messaging 

Exchange 2003 and 2000 All Local Msg Delivery SLA 

Exchange 2003 and 2000 MTA Msg Trends 

Exchange 2003 and 2000 MTA Queue Data Stats 

Exchange 2003 and 2000 SMTP Connections 

Exchange 2003 and 2000 SMTP Msg Trends 

Exchange 2003 and 2000 SMTP Virtual Server Stats

Exchange 2003 and 2000 Message Tracking Stats 

Exchange 2003, 2000, and 5.5 Top Destinations

Exchange 2003, 2000, and 5.5 Top Recipients 

Exchange 2003, 2000, and 5.5 Top Senders

Exchange 2003, 2000, and 5.5 Top Sources

Exchange 2003, 2000, and 5.5 Message Delivery SLA

Public Folder Store

Exchange 2003 and 2000 Folder Summary 

Exchange 2003 and 2000 Folder Usage Trends 

Exchange 2003 and 2000 Inactive Folders 

Exchange 2003 and 2000 Public Folder Store Stats 

Exchange 2003 and 2000 Public Folder Store Msg Tnd 

Exchange 2000 and 2003 Top 100 Public Folders 
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Exchange 2000 reports

Exchange SPI reports for Exchange 2000 are located on the OVO console under Reports and 
Graphs → Reports → SPI for Exchange 2000, in the following groups:

Chat

Exchange 2000 Chat Trends

Client Access

Exchange 2003 and 2000 IMAP4 Connections

Exchange 2003 and 2000 MAPI Logon SLA 

Exchange 2003 and 2000 MAPI Send SLA 

Exchange 2003 and 2000 Message Read SLA 

Exchange 2003 and 2000 OWA Authentications

Exchange 2003 and 2000 OWA Connections

Exchange 2003 and 2000 OWA Usage 

Exchange 2003 and 2000 POP3 Connections 

Exchange 2003 and 2000 Messaging Ports 

Conferencing 

Exchange 2000 Conferencing Server Trends

Exchange 2000 MCU Trends 

Exchange Server 

Exchange 2003 and 2000 System Information Summary 

Information Store

Exchange 2003 and 2000 IS Users and Connections

Exchange 2003 and 2000 Full Text Indexing Stats

Exchange 2003 and 2000 Transaction Log Stats 

Instant Messaging    

Exchange 2000 Instant Messaging Availability Trends

Exchange 2000 Instant Messaging Users Growth

Mailbox Store 

Exchange 2003 and 2000 Inactive Mailboxes   

Exchange 2003 and 2000 Mailbox Details 

Exchange 2003 and 2000 Mailbox Store Stats 

Exchange 2003 and 2000 Mailbox Summary 

Exchange 2003 and 2000 Mailbox Store Msg Trends 

Exchange 2003 and 2000 Mailbox Usage Trends   
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Exchange 2000/2003 Top 100 Mailboxes 

Messaging

Exchange 2003 and 2000 All Local Msg Delivery SLA 

Exchange 2003 and 2000 MTA Msg Trends 

Exchange 2003 and 2000 MTA Queue Data Stats 

Exchange 2003 and 2000 SMTP Msg Trends 

Exchange 2003 and 2000 SMTP Connections

Exchange 2003 and 2000 Message Tracking Stats    

Exchange 2003, 2000, and 5.5 Top Destinations 

Exchange 2003, 2000, and 5.5 Top Recipients 

Exchange 2003, 2000, and 5.5 Top Senders 

Exchange 2003, 2000, and 5.5 Top Sources 

Exchange 2003, 2000, and 5.5 Message Delivery SLA

Exchange 2003 and 2000 SMTP Virtual Server Stats 

Public Folder Store 

Exchange 2003 and 2000 Folder Summary 

Exchange 2003 and 2000 Folder Usage Trends

Exchange 2003 and 2000 Inactive Folders 

Exchange 2003 and 2000 Public Folder Store Stats

Exchange 2003 and 2000 Public Folder Store Msg Tnd 

Exchange 2000/2003 Top 100 Public Folders 
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Exchange 5.5 reports

Exchange Server 

Exchange 5.5 System Information Summary 

Information Store 

Exchange 5.5 User Connections

Mailbox Database 

Exchange 5.5 Mailbox Details 

Exchange 5.5 Mailbox Summary 

Exchange 5.5 Mailbox Usage Trends 

Exchange 5.5 Top 100 Mailboxes 

Messaging 

Exchange 5.5 IMS Messaging Trends 

Exchange 5.5 Messaging Trends 

Exchange 5.5 Message Delivery SLA 

Exchange 2003, 2000 and 5.5 Top Destinations 

Exchange 2003, 2000 and 5.5 Top Recipients 

Exchange 2003, 2000 and 5.5 Top Senders

Exchange 2003, 2000 and 5.5 Top Sources 

Public Folder Database 

Exchange 5.5 Folder Summary 

Exchange 5.5 Folder Usage Trends 

Exchange 5.5 Top 100 Public Folders 
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Exchange SPI Graphs

Exchange SPI comes with a set of pre-configured graphs. They are located on the OVO console 
tree in the Operations Manager → Reports and Graphs → Graphs folders. 

To display a graph, double-click the desired graph. The Display graph associated with dialog 
box opens:

Select the nodes to retrieve data from, the date range, and the level of granularity. Check to 
periodically update the data in the graph, or to use Java graphs.
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Figure 9 Example DSAccess Hit-Miss Ratio Graph
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Exchange 2007 Graphs

Exchange SPI provides pre-configured graphs for Microsoft Exchange Server 2007. To view 
these graphs, expand Reports and Graphs → Graphs → SPI for Exchange 2007 in the console tree.

Client Access

Outlook Client Failures: This graph shows the percentage of RPCs failed in different 
categories.

IMAP4 Connections: This graph shows the IMAP4 connection activity.

MAPI RPC Performance: This graph shows metrics of information store RPC requests and 
RPC operations rate (operations/sec). 

MAPI RPC Latency Levels: This graph shows the number of successful RPCs with different 
Outlook client latency levels. 

POP3 Connections: This graph shows the POP3 connection activity. 

POP3 Performance: This graph shows POP3 messages delivered to mailboxes. 

Outlook Client RPC Performance: This graph shows the Outlook Client RPC 
Performance. 

Information Store

Information Store Users and Connections: This graph shows user and connection count 
metrics for the current day. 

Virtual Memory 16MB Free Block Trend: This graph shows information store virtual 
memory 16MB free block use trends.  

Virtual Memory Large Free Block Megabytes Usage: This graph shows information 
store virtual memory large free block megabytes usage.  

Virtual Memory Largest Block Size: This graph shows the change of the information store 
virtual memory largest block size.  

Mailbox Store

Mailbox Store Delivery Time: This graph shows hourly metrics for the average delivery 
times of messages to Exchange server private and public mailboxes. 

Mailbox Store Message Volume: This graph shows Exchange server private mailbox 
volume.

Mailbox Store Queues: This graph shows Exchange server mailbox store queue lengths.

Public Folder Store

Public Folder Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of local messages to Exchange servers. 

Public Folder Store Message Volume: This graph shows Exchange server public folder 
volume. 

Public Folder Store Queues: This graph shows Exchange server public folder store queue 
lengths.
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Exchange 2003 Graphs

Exchange SPI comes with an array of pre-configured graphs. In the console tree, open Reports 
and Graphs → Graphs → SPI for Exchange 2003. Graphs are located in the following folders:

Client Access 

ActiveSync Performance: This graph shows the ActiveSync Microsoft Exchange active 
directory, connection, and pending requests. 

ActiveSync Users: This graph shows the current users of Microsoft Exchange 
ActiveSync. 

IMAP4 Connections: This graph shows the IMAP4 connection activity. 

IMAP4 Performance: This graph shows the IMAP4 transaction activity. 

MAPI RPC Latency levels: This graph shows the number of successful RPCs with 
Outlook client latency levels.

MAPI RPC Performance: This graph shows metrics of information store RPC requests 
and RPC operations rate (operations/sec). 

Number of Successful RPCs with Different Latency Levels: This graph shows the 
number of successful RPCs with different Outlook client latency levels. 

Outlook Client RPC Performance: This graph shows the Outlook Client RPC 
Performance. 

OWA Connections: This graph shows the OWA connection activity. 

OMA Response Time: This graph shows the MSExchangeOMA last response time in 
seconds. 

POP3 Connections: This graph shows the POP3 connection activity. 

POP3 Performance: This graph shows POP3 messages delivered to mailboxes. 

Directory Service

DSAccess Cache Hit-Miss Ratio: This graph shows MSExchangeDSAccess cache hit 
and miss ratio for Exchange 2000 and 2003 servers.

Site Replication Service Space Free: This graph shows the percentage of free space on 
the Site Replication Service volume.

Site Replication Service Space Used: This graph shows Site Replication Service space 
usage on the Exchange server.

Information Store

Full-Text Indexing Space Usage: This graph shows disk space usage for full-text 
indexing of Microsoft Exchange information stores. 

Information Store Users and Connections: This graph shows user and connection 
count metrics, for the current day. 

Virtual Memory 16MB Free Block Trend: This graph shows information store virtual 
memory 16MB free block use trends. 

Virtual Memory Large Free Block Megabytes Usage: This graph shows information 
store virtual memory large free block megabytes usage. 

Virtual Memory Largest Block Size: This graph shows the change of the information 
store virtual memory largest block size. 
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Transaction Log Percentage Free: This graph shows the percentage of free space on 
the transaction log volumes. 

Transaction Log Space Used: This graph shows Exchange server transaction log space 
usage on the Exchange server. 

Mailbox Store

Mailbox Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of messages to Exchange server private and public mailboxes. 

Mailbox Store EDB Database Statistics: This graph shows Exchange server private 
mailbox store database statistics.

Mailbox Store Streaming Database Statistics: This graph shows Exchange mailbox 
store streaming database statistics.

Mailbox Store Storage Usage: This graph shows mailbox store storage usage.

Mailbox Store Message Volume: This graph shows Exchange server private mailbox 
volume.

Mailbox Store Queues: This graph shows Exchange server mailbox store queue lengths.

Messaging

MTA Message Volume: This graph shows Exchange server Message Transfer Agent 
volume. 

MTA Queues: This graph shows Exchange server queue lengths. 

SMTP Connections: This graph shows SMTP virtual server connections on the 
Exchange server. 

SMTP Queues: This graph shows SMTP server queues on the Exchange server 

SMTP Message Volume: This graph shows SMTP volume on the Exchange server. 

SMTP Queue, Badmail, and Pickup Counts: This graph shows SMTP badmail, 
pickup and queue item counts for each SMTP virtual server. 

SMTP Queue, Badmail, and Pickup Size: This graph shows SMTP badmail, pickup 
and queue sizes for each SMTP virtual server. 

X400 MTA Queue Space Usage: This graph shows disk space usage for X400 service 
MTA queue.

Public Folder Store

Public Folder Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of local messages to Exchange servers. 

Public Folder Store EDB Database Statistics: This graph shows Exchange server 
public folder store (edb) database statistics. 

Public Folder Store Message Volume: This graph shows Exchange server public folder 
volume. 

Public Folder Store Streaming Database Statistics: This graph shows Exchange 
Public Folder store streaming database statistics. 

Public Folder Store Storage Usage: This graph shows Exchange server public folder 
usage. 
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Public Folder Store Queues: This graph shows Exchange server public folder store 
queue lengths.
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Exchange 2000 Graphs

Exchange 2000 graphs are arranged in the following service groups:

Client Access

IMAP4 Connections: This graph shows the IMAP4 connection activity. 

IMAP4 Performance: This graph shows the IMAP4 transaction activity. 

MAPI RPC Performance: This graph shows metrics of information store RPC requests 
and RPC operations rate (operations/sec). 

OWA Connections: This graph shows the OWA connection activity. 

POP3 Connections: This graph shows the POP3 connection activity. 

POP3 Performance: This graph shows POP3 messages delivered to mailboxes. 

Directory Service

DSAccess Cache Hit-Miss Ratio: This graph shows MSExchangeDSAccess cache hit 
and miss ratio for Exchange 2000 and 2003 servers.

Site Replication Service Space Free: This graph shows the percentage of free space on 
the Site Replication Service volume.

Site Replication Service Space Used: This graph shows Site Replication Service space 
usage on the Exchange server.

Information Store

Full-Text Indexing Space Usage: This graph shows disk space usage for full-text 
indexing of Microsoft Exchange information stores. 

Information Store Users and Connections: This graph shows user and connection 
count metrics, for the current day. 

Transaction Log Percentage Free: This graph shows the percentage of free space on 
the transaction log volumes. 

Transaction Log Space Used: This graph shows Exchange server transaction log space 
usage on the Exchange server. 

Virtual Memory 16MB Free Block Trend: This graph shows information store virtual 
memory 16MB free block use trends. 

Virtual Memory Large Free Block Megabytes Usage: This graph shows information 
store virtual memory large free block megabytes usage. 

Virtual Memory Largest Block Size: This graph shows the change of the information 
store virtual memory largest block size. 

Mailbox Store

Mailbox Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of messages to Exchange server private and public mailboxes. 

Mailbox Store EDB Database Statistics: This graph shows Exchange server private 
mailbox store database statistics.

Mailbox Store Message Volume: This graph shows Exchange server private mailbox 
volume.
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Mailbox Store Streaming Database Statistics: This graph shows Exchange mailbox 
store streaming database statistics.

Mailbox Store Storage Usage: This graph shows mailbox store storage usage.

Mailbox Store Queues: This graph shows Exchange server mailbox store queue lengths.

Messaging

MTA Message Volume: This graph shows Exchange server Message Transfer Agent 
volume. 

MTA Queues: This graph shows Exchange server queue lengths. 

SMTP Connections: This graph shows SMTP virtual server connections on the 
Exchange server. 

SMTP Message Volume: This graph shows SMTP volume on the Exchange server. 

SMTP Queues: This graph shows SMTP server queues on the Exchange server 

SMTP Queue, Badmail, and Pickup Counts: This graph shows SMTP badmail, 
pickup and queue item counts for each SMTP virtual server. 

SMTP Queue, Badmail, and Pickup Size: This graph shows SMTP badmail, pickup 
and queue sizes for each SMTP virtual server. 

X400 MTA Queue Space Usage: This graph shows disk space usage for X400 service 
MTA queue.

Public Folder Store

Public Folder Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of local messages to Exchange servers. 

Public Folder Store EDB Database Statistics: This graph shows Exchange server 
public folder store (edb) database statistics. 

Public Folder Store Message Volume: This graph shows Exchange server public folder 
volume. 

Public Folder Store Streaming Database Statistics: This graph shows Exchange 
Public Folder store streaming database statistics. 

Public Folder Store Storage Usage: This graph shows Exchange server public folder 
usage. 

Public Folder Store Queues: This graph shows Exchange server public folder store 
queue lengths.
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Exchange 5.5 Graphs

The Exchange 5.5 graphs are organized in the following categories:

Information Store 

Delivery: This graph shows hourly metrics for the average delivery times of messages to 
Exchange server private and public mailboxes.

Users: This graph shows information store user count metrics, for the current day.

Mailbox Database

Mailbox Usage: This graph shows Exchange server mailbox usage.

Private Mailbox Volume: This graph shows Exchange server private mailbox volume.

Messaging

Internet Mail Queue: This graph shows the Exchange server Internet Mail Service 
queue count. 

Internet Mail Volume: This graph shows Exchange server Internet Mail Connector 
volume. 

MTA Volume: This graph shows Exchange server Message Transfer Agent volume. 

Newsfeed Volume: This graph shows Exchange server newsfeed volume. 

Queues: This graph shows Exchange server queue lengths. 

Public Folder Database

Public Folder Usage: This graph shows Exchange server public folder usage.

Public Folder Database: This graph shows Exchange server public folder volume.
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8 Exchange SPI Tools
Tools enable you to perform tasks to facilitate Microsoft Exchange Server monitoring. With 
the help of tools, you can perform certain configuration tasks on managed nodes to start 
monitoring Microsoft Exchange Server.

Exchange SPI Tools for Microsoft Exchange Server 2007

The following tools are available:

• Create Data Sources — When you run this tool on a Microsoft Exchange Server 2007 
node, it creates databases on the OVO agent’s data store, which can be used by collectors 
to log metric data. The tool creates databases in the embedded performance component 
(CODA) of the agent.

• Register DataCollectors — This tool registers COM components on the node required 
by the collectors.

• Start ExData Collection Manager — This tool starts the collection manager process on 
the managed node. Collection manager is a background process, which runs on a managed 
node. Collection manager creates objects necessary to analyze and publish the data 
collected by individual collectors.

• Start PowerShell Collector — This tool starts another background process — 
PowerShell collector — on the managed node. 

• Stop PowerShell Collector — Run this tool to stop the PowerShell collector process on 
a managed Microsoft Exchange Server 2007 node.

• Stop ExData Collection Manager — Run this tool to stop the collection manager 
process on a managed Microsoft Exchange Server 2007 node.

• PowerShell Collection Configuration Utility — This tool launches PowerShell 
collection configuration utility. PowerShell collection configuration utility enables you to 
create and modify collection definitions. A collection is a description that specifies the 
mechanism to collect, analyze, and store metric data for Microsoft Exchange Server 2007. 
With the help of the graphic user interface, you can create new collection definitions, or 
modify existing definitions. 

• Exchange Cluster Configuration — This tool helps you create the apminfo.xml file to 
enable monitoring of Microsoft Exchange Server 2007 cluster nodes. 

• Exchange SPI Trace — This tool sets the trace levels on managed nodes. Launch this 
tool if you need to collect troubleshooting information from nodes. 

• Self-Healing Info — The Self-Healing Info tool gathers system information, and 
configuration, log, and trace Exchange SPI files, for assisting to troubleshoot problems. 
Gathered information and files are placed in a pre-defined output directory. The data 
collector gathers real-time data, which reduces the probability of troubleshooting with 
stale data.
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• Self-Healing Verification — Launch this tool to detect any version mismatch between 
the Exchange SPI and the instrumentation files. If the tool detects any mismatch, it 
displays error message  in the tool status window.

Exchange SPI Tools for Microsoft Exchange Server 2000 and 
2003

The following groups of tools are available:

Client SLA Configurations

This tool group contains the following tools for MAPI-based client probes:

• Configure Client MAPI Logon

• Configure Client Message Read 

• Configure Client Message Send 

• MBOX creation for MAPI client based policies 

These tools, used together with associated policies, generate and collect Service Level 
Objective data on various basic client tasks such as logon, sending, and reading E-mail 
messages. See the online Help for more information and procedures.

End-to-End SLA Configuration

• MBOX Config: starts the mailbox configuration program that automatically configures a 
mailbox. The user name and password of a service account with Exchange administrative 
privileges needs to be given for the tool to execute.

• End-to-End Configuration: This tool is a wizard for configuring the Message Delivery 
(Ping) Service Level Objective process on Exchange 2000 and 2003 OVO managed servers.

See Configuring Exchange SPI for Message Delivery SLAs on page 53 for more information.

Exchange Server Utilities

• Enable Message Tracking: Enables message tracking on Exchange 2000 and Exchange 
2003 servers. 

• Mount Exchange Information Store: This tool can search for and mount dismounted 
information or public folder stores. For more information on this tool, see the Exchange 
SPI online help. 

EXSPI Support

• Trace On/Tracing Off: This tool enables and disables tracing. The default setting is off. 
Tracing is generally used by customer support for troubleshooting purposes.

• Self Healing Info: This tool gathers system information, and configuration, log, and 
trace Exchange SPI files to help troubleshoot problems. See the online help for more 
information.
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Exchange Topology

• OV Topology Viewer: This tool provides for the visualization of Microsoft Exchange and 
directory servers, with a 3-dimensional perspective. See OV Topology Viewer on page 125 
for more details.
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ovo Utilities

• Exchange Cluster Configuration: This tool prints apminfo data, which can be used to 
create the apminfo.xml file used by the Exchange SPI to recognize clustered instances. For 
further information about Exchange SPI monitoring clusters, see Exchange SPI 
Clustering Support on page 67.

• Embedded Performance Component Configuration: This tool creates the 
EXSPI_DATA datasource, classes and metrics. It performs the same functions as the Auto 
Deploy policy EXSPI-6.X exspi Agent Configuration in the ovo Exchange SPI core 
> Data Collection group. The tool lists all current datasources prior to creation of the 
EXSPI_DATA datasource. To verify successful creation, wait a few minutes after initial 
execution, and execute the tool again. See Embedded Performance Component (EPC) 
Schema on page 161 for a complete listing of the EPC schema.

Exchange SPI Tools for Microsoft Exchange Server 5.5

For Exchange 5.5, the following tools are available:

• The Exchange SPI MBOX Config tool starts the mailbox configuration program that 
automatically creates and configures a mailbox. The user name and password of a service 
account with Exchange User and mailbox creation administrative privileges, needs to be 
given for the tool to execute.

• The Trace On/ Tracing Off tool enables or disables tracing. The default setting is off. 
Tracing is generally used by customer support for troubleshooting purposes.
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OVO Foundation Tools

Some Exchange 5.5 Advanced policies require a Domain Admin account. To help manage 
those accounts, a tool called ovpmpwutil has been added to the OVO foundation tools. This 
tool is not SPI specific. Documentation for ovpmpwutil can be found in the Command-line 
Tools section of the HP OpenView Operations for Windows online help.

OV Topology Viewer

The OV Topology Viewer lets you visualize your Microsoft Exchange Server 2000 and 2003 
environment from a three-dimensional perspective. The viewer is a tool located in the OVO 
console under Tools >  SPI for Exchange > Exchange 2000 and 2003 > Exchange 
Topology. Using this tool you can quickly visualize routing groups, Exchange servers and the 
roles they play within your Exchange organization, by selecting the Exchange Topology 
folder on the console tree. 

To open the Exchange Topology viewer:

1 Select Tools > SPI for Exchange > Exchange 2000 and 2003 > Exchange Topology.

2 Double-click OV Topology Viewer.

3 The OV Topology Viewer opens. In the left pane, right click Forests, and select Add 
Forest....

This release of the Exchange SPI does not provide Topology Viewer tool for Exchange Server 
2007.

If you also have the OpenView Active Directory SPI installed, the OV Topology Viewer 
opens with two folders: Exchange Topology and Site Topology. The Site Topology view 
displays Active Directory and Exchange server information. For more details on the Site 
Topology view see the Active Directory SPI online help and Configuration Guide.
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4 Identify the Domain Controller or Active Directory Domain which will be interrogated for 
Exchange data. Before selecting the Advanced Exchange Data Collection checkbox, see 
Advanced Exchange Data Collection on page 128. Enter the requested information. Click 
OK.

You are informed when the data collection is complete.

5 Click Close, or check the Close the dialog when complete box if you prefer that this 
dialog close automatically in the future.

6 Select Exchange Topology in the left pane. An untitled view of your Exchange Topology 
is displayed in the right pane. Save this view for future use.
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7 Expand the folders to see your Exchange Organization hierarchy.
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 Advanced Exchange Data Collection

Whether or not the OV Topology Viewer can collect particular Exchange data will depend on 
the specific permissions assigned to components of your Exchange organization, see How can I 
tell if I have WMI access to an Exchange Server? on page 134.
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On the Connect to Forest... screen, if the option Advanced Data Collection is checked you 
will see the following warning: 

As the warning indicates, the retrieval of this information from a large Exchange 
Organization can take a number of hours. In addition, if it is not successful due to these 
permission limitations, you will not be notified, but must check the error log files for 
connection difficulties to determine if your privileges were sufficient. See Required WMI 
Security Access Permissions on page 135 for details of required WMI permissions and error 
log file locations.

If you select not to initially collect this data from your entire Exchange organization, OV-TV 
will try to retrieve this same data when the Properties dialog of individual servers is opened. 
If the permissions allow, the query will retrieve data and populate the Dependent DC tab on 
the server Properties dialog. If Advanced Exchange Data Collection is selected initially, this 
tab on the Properties dialog of any servers (where the permissions permit) will be populated.

Site Topology Viewer

If you have an Active Directory SPI license, there will be a Site Topology folder on the console 
tree, beneath the Exchange Topology folder. 

The Site Topology view shows both Active Directory (AD) and Exchange servers on the same 
map, when: 

• both SPIs are installed

• the correct permissions were set to allow the collection of Exchange data

• Advanced Exchange Data Collection has been performed with the initial data collection 
(through checking the check box).

The advanced Exchange data collection gathers information about where in the Active 
Directory sites the Exchange servers live, and the dependent domain controllers. This 
Exchange information will be present in the Site Topology map, which opens in the details 
pane when you select this folder on the console tree. For more information on the Site 
Topology view, see the Active Directory SPI online Help and Configuration Guide.

Getting Started with the Exchange Topology Viewer

When the OV Topology Viewer opens, on the left are folders containing routing groups and 
servers. On the right is a graphical representation that places the routing groups and server 
links within a context. While the tree view on the left displays the hierarchy of the Exchange 
organization, the right pane shows the non-hierarchical relationships among its components.
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Accessing functions: The OV Topology Viewer’s features can be accessed through its menu 
commands, its toolbar buttons, or by context menus within areas on either side of the window 
pane. For complete menu and toolbar descriptions, refer to the SPI for Exchange online help.    

Manipulating the Exchange Topology View

You may find when you view the Exchange Topology map that servers do not appear within 
the viewable area. You may also want to resize the viewable area. These and other changes 
are possible as follows: 

Table 1 Modifying the OV Topology Viewer  

Tree/map modification How to do it

To move servers to different 
locations within their 
routing groups.

Drag and drop the server to the desired tile within its 
routing group.

To increase/decrease size of 
row/columns in the map’s 
grid.

Right-click the unused space on or off the map and 
select View Properties, and the General tab.

To find a server in the tree. On the map, right-click a server and select Find 
Server in Tree.
(Label appears highlighted)

To find a server in the map. In the tree, right-click on the server and select Find 
Server on Map.
(Label appears bold, with larger text)

Move a routing group to a 
different area of the grid

Method #1:

1. Pressing the left mouse button, click the 
routing group and start to drag and drop to 
the desired area.

2. Drag to edge of view to auto scroll the view.

Method #2

1. Pressing the left mouse button, select the 
routing group and start to drag and drop to 
the desired area.

2. Still holding the left mouse button down, 
use the arrow keys to change the view of the 
map.
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Using the Keyboard to Navigate the Map

.

Table 2 Keyboard Functionality

Keystroke Map function

← left arrow Scrolls the map view to the left approximately 
one tile width.

→ right arrow Scrolls the map view to the right approximately 
one tile width.

Home Scrolls the map view to the left extent. (Vertical 
position remains the same).

End Scrolls the map view to the right extent. 
(Vertical position remains the same).
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Accessing Server and Map Properties

After successfully connecting to a forest, the tree is populated and a topological map is 
displayed. 

By right-clicking any discovered Exchange server in either the tree or the map and selecting 
Properties, you can view the following Exchange server information:

Server Properties 

The information displayed in the server Properties dialog (DNS Host Name, Distinguished 
Name, Object GUID, Server Roles and Dependent Domain Controllers), will be derived from 
the initial Active Directory query (see Advanced Exchange Data Collection on page 128). If 
little or no information is displayed, it is probably a result of the required WMI permissions 
not being granted, see Required WMI Security Access Permissions on page 135.

The server properties information is cached, click Refresh Data if you want the data to be 
updated.
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The Dependant DC Tab

The Dependant domain controllers are listed with their DNS Name, and their Type. If the 
Advanced Exchange Data Collection option was checked initially, this data has already been 
collected and will display. If the option was not checked initially, selecting to view the Server 
Properties activates the collection of this data and it will display in the dialog if the 
appropriate security authorizations are set.

Type: Any of the three types of roles the domain controller can have: Authentication, Global 
Catalog or Configuration.
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Map Properties 

By right-clicking on an unused area of the grid or space off the grid, you can open the 
Exchange Messaging View menu, with the following options:

— Navigator: Allows you to view and navigate the entire grid, giving you an overview of 
what you are seeing. The blue rectangle represents the area visible in the main view.

— Clear Find: If an object on the map is in focus as a result of the right-click menu option 
Find in View, this will be enabled, and you can select to clear the find.

— View Properties: Many variables of the map view can be modified, for example colors 
of routing groups and lines, as well as line widths and styles.

For more information about the OV Topology Viewer, see the Exchange SPI online Help.

If you have the Active Directory SPI installed and wish to view Active Directory detail 
using the Site Topology View, see the Active Directory SPI online Help. 

FAQs

Can I print the map image? 

No. But you can export the map, save it as .png or as a bitmap file, then open it in a graphics 
program to print the file.

How can I tell if I have WMI access to an Exchange Server?

1  Look in the <OVTV install 
directory>\release\logs\AD_OvADExCollectorErrorLog.txt log file.

2  Look for a warning such as:

03/01/05 11:44:53 WARNING: Exception thrown, HR#80070005, Access is denied. 
WMI connection failed to server 'myExchangeServer01.americas.mycorp.net'. 
FileName: .\OvWmiQuery.cpp Line#128

Or

02/24/05 17:36:24 WARNING: Exception thrown, HR#80041008,  WMI connection 
failed to server 'myExchangeServer01.americas.mycorp.net'. FileName: 
.\OvWmiQuery.cpp Line#126 

What log files does OVTV generate?

When you launch OV-TV, it generates OVTV_ConsoleErrorLog.txt and 
OVTV_OvADExCollectorErrorLog.txt 

files located at:

       OVTV install directory>\release\logs\

If you shut down OV-TV, or simply cancel out, or stop then reconnect to a forest, the previously 
created OVTV_ConsoleErrorLog.txtlog file is rolled over into 
OVTV_ConsoleErrorLog.old.txt and the previously created 
OVTV_OvADExCollectorErrorLog.txt is rolled into 
OVTV_OvAdExCollectorErrorLog.old.txt.

Note that the OVTV_OvADExCollectorErrorLog.txt is created only if you receive a 
warning. If no warning occurs, then no files are created.
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Required WMI Security Access Permissions 

The following permissions are required for the OV Topology Viewer to collect advanced 
Exchange data:

— To get Exchange server site membership data, the OV-TV user must have READ and 
REMOTE access to the WMI namespace root\default.

— To get Exchange server DC dependency data, the OV-TV user must have READ and 
REMOTE access to the WMI namespace root\MicrosoftExchangeV2.

— And to get the DNS servers of a DC, the OV-TV user must have READ and REMOTE 
access to the WMI namespace root\CMIv2.
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A Exchange SPI Instrumentation Files
EXSPI Exchange Discovery Instrumentation

Exchange 2007 EXSPI Instrumentation

EXSPI_CreateServices.js Discovers hosted on Services

msexchange.apm.xml Cluster support file, identifies policies 
to enable/disable

OvExchDisc.exe Discovers virtual Services

exspi_RunDiscovery.js Resource group identification for 
rediscovery after a cluster failover

HP.OV.SPI.Composer.exe Files required by the PowerShell 
Collection Configuration Utility.HP.OV.SPI.CollectionFlowPane.dll

CmdLetCommands.xml

Interop.OVPMADLib.dll

HP.OV.SPI.ExDataCollector.dll Used by the Exchange data collector. 

SNCOLLECTORKEY.SNK

SYSTEM.MANAGEMENT.AUTOMA
TION.DLL

HP.OV.SPI.ExCollectorServer.exe Used by the ExCollector server.

HP.OV.SPI.ExDataCollector.dll

SYSTEM.MANAGEMENT.AUTOMA
TION.DLL

Analyzer.dll Used by the analyzer.

AnalyzerInfo.xml

HP.OV.SPI.CollectionManager.exe Used by the Collection Manager 
service.SPIMetaData.xml

HP.OV.SPI.ExScheduler.exe Used by the scheduler.

PSCollector.dll Used by the PowerShell Collector 
service.HP.OV.SPI.ExDataCollector.tlb

CollectorInfo.xml

PSPublisher.dll Used by the data store mechanism.

PublisherInfo.xml
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xerces-c_2_7d.dll Miscellaneous files.

HP.OV.SPI.Terminator.exe

Register.bat

ex2007_*.spec Database schema definitions.
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Exchange 200X EXSPI Instrumentation

exspi_e2k.exe Collector used through schedules

exspidatasource.exe Creates database schema

EXSPI*.spec Database schema definitions

ovam*.dll Tracking log collection library

hpudm.txt Metric definitions

exspitra.vbs Turn Exchange SPI data collection 
tracing on and off

exspi_tracklog.vbs Turn Exchange tracking log file 
generation on

exspi_e2k_cfg Create mailbox

exspi_dbmount.vbs Checks mount/dismount Information 
Store

exspi_StartService.vbs Starts a service

end-to-end.xml End-to-End Config file. This file exists 
after the execution of End-to-End 
Config tool

exspi_e2k_clust_config.js For Cluster Configuration

spi_msexch*.*

shs*.*

Self healing Service support files

exspi_ports.exe Determines if SMTP, HTTP, POP3, 
and IMAP4 ports are responding

exspi_checkMemCfg.wsf

exspi_checkMemoryConfig.vbs

exspi_cMemoryConfig.vbs

Check memory settings for Exchange 
Mailbox and public Folder Servers

exspi_e2k_tlog.js

exspi_e2k_tlog.vbs

exspi_e2k_tlog.wsf

exspi_e2k_tlog_lib.vbs

Used for gathering tracking log data. 
(Average delivery time for email sent 
on current server).

exspi_cml_cfg.wsf

exspi_cmr_cfg.wsf

exspi_cms_cfg.wsf

Tools for creating Mapi client SLA 
values.

exspi_agent.vbs

exspi_core.vbs

Shared scripts with agent functions

exspi_e2k_client_lib.vbs Shared script for Client response time 
scripts
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Exchange 5.5 EXSPI Instrumentation

exspi_e2k_cmr.vbs

exspi_e2k_cmr.wsf

Mapi Client Message Read response 
time scripts

exspi_e2k_send.vbs

exspi_e2k_send.wsf

Mapi Client Message Send response 
time scripts

exspi_e2k_logon.vbs

exspi_e2k_logon.wsf

Mapi Client Message Logon response 
time scripts

exspi_e55.exe Collector used through schedules

exspidatasource.exe Creates EPC database schema

EXSPI*.spec Database schema definitions

ovam*.dll Tracking log collector libraries

hpudm.txt Metric definitions

exspitra.vbs Turn Exchange SPI data collection 
tracing on and off

exspi_e55_cfg.exe Create mailbox

spi_msexch*.*

shs*.*

Self healing Service support files
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B Customizing Policies
A policy is a rule or set of rules that helps you automate network and service administration. 
The Exchange SPI provides you a range of policies to simplify your Exchange Server 
monitoring tasks. You can customize existing policies from the OVO console.

Customize Policies Using the Tag Feature

If you have servers dedicated to specific sites or business units, you may find it effective for 
those servers to have uniquely named Exchange SPI policies. In such cases, copy default 
policies into new groups, affix prefixes to the original names, and include them in the schedule 
policy that collects data during that measurement interval.

Task 1: Create a new Policy Group 

1 In the console tree, expand the Policy management → Policy Groups folders.

2 Right-click the folder in which you want to locate the new group, and then select New → 
Policy Group.

3 Type the new group name for the folder created, and then click Enter.

4 In the console, use Shift+click or Ctrl+click to select the default policies to be in the group, 
right-click, and then select Copy.

5 Right-click the newly created group and click Paste. The copied policy will be pasted into 
the new Policy group.

6 If you copied an entire group of default policies into the new group, you can eliminate 
those you do not need by right-clicking them and selecting Delete.

Task 2: Tag the Policies

1 Double-click each policy and make any changes to the policy desired. 

Remember to always copy scheduled task policies from the default policy group 
containing the measurement threshold policy you are copying to the new policy 
group. The scheduled task policy is necessary for any data collection to occur.
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2 Select File → Save As. In the dialog that appears enter the special prefix followed by a 
hyphen in front of the default policy name; for example Example-EXSPI-6.X IS Mailbox 
Average Delivery Time. 

3 After saving any renamed policies, double-click the scheduled task policy that you copied 
to the new group together with the other policies. (In the example, EXSPI-6.X 
Id-Dc-Instant Messaging is used.)

4 In the Command* text box at the end of the text, insert the tag (-t) parameter and the 
<prefix>- 

5 When finished, rename the scheduled task policy to include the group prefix, in this way: 

Select File → Save As and rename the EXSPI-6.X Id-Dc-Instant Messaging scheduled task 
policy to Example-EXSPI-6.X Id-Dc-Instant Messaging.

The prefix attached to the beginning of each policy in the new group makes the policies easy to 
find in the Policies grouped by type folder in the console. Also, creating a new group for the 
new policies gives you an efficient means to deploy them (right-click the group and select All 
Tasks → Deploy on...). See the Online Help for more details.
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C Service Reporter Schema
In all EXSPI Reporter database tables, the first five columns have to be ID, 
SYSTEMNAME, DATETIME, GMT, SHIFTNAME, and in that order. No 
EXSPI data can be gathered if the first five column names or their order are 
different from this.

EXSPI_PFSUMMARY
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INTERVAL_KEY
     SERVER_NAME
     ADMINGROUP
     
STORAGEGROUP_NAME
     DATABASE_NAME
     EDBPATH
     STMPATH
     EDBSIZE
     STMSIZE
     EDBFREE
     STMFREE
     EDBTOTAL
     STMTOTAL
     PFLOGICALSIZE
     FOLDER_MSGCNT
     FOLDER_COUNT
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EXSPI_PFPERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     SERVER_NAME
     PFDELIVERYTIME
     PFDELIVER
     PFSENT
     PFSUBMITTED
     PFRECIPIENT
     PFACTIVELOGON
      PFLOGON
      PFLOGONPEAK
      PFSIRATIO
      PFRECOVERITEMS
      PFRECOVERSIZE
      PFREPRCVD
      PFREPSENT
      PFREPQ

EXSPI_MBDETAIL
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INTERVAL_KEY
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     MAILBOX_NAME
     MAILBOX_SIZE
     MAILBOX_QUOTA
     MAILBOX_MSGCNT
     MAILBOX_LASTACCESS
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EXSPI_MBSUMMARY
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INTERVAL_KEY
     SERVER_NAME
     ADMINGROUP
     
STORAGEGROUP_NAME
     DATABASE_NAME
     EDBPATH
     STMPATH
     EDBSIZE
     STMSIZE
     EDBFREE
     STMFREE
     EDBTOTAL
     STMTOTAL
     MBLOGICALSIZE
     MAILBOX_USRCNT
     MAILBOX_MSGCNT

EXSPI_MBPERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCEL_NAME
     SERVER_NAME
     MBDELIVERYTIME
     MBLOCALDELIVER
     MBDELIVER
     MBSENT
     MBSUBMITTED
     MBRECIPIENT
     MBACTIVELOGON
     MBLOGON
     MBLOGONPEAK
     MBSIRATIO
     MBRECOVERITEMS
     MBRECOVERSIZE
     MBSIRATIO
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EXSPI_TRANSLOG
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INTERVAL_KEY
     SERVER_NAME
     
STORAGEGROUP_NAME
     TRANSLOGFILEPATH
     TRANSLOGFILESIZE
     TRANSLOGFILEFREE
     TRANSLOGFILETOTAL

EXSPI_OMA
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     OMASENT
     OMAIGNORE
     OMADISCARD
     OMARESPONSE

EXSPI_ASYNC
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     EXSPI_ASYNC
     ASYNCSENDMAIL
     ASYNCCMDS
     ASYNCCLIENTITEMS
     ASYNCSERVERITEMS
     ASYNCAD
     ASYNCCONNECT
     ASYNCPENDING
     ASYNCUSERS
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EXSPI_ASNOTIFY
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     ASNTOTAL
     ASNSENT
     ASNIGNORE
    ASNDISCARD
     ASNEXPIRED
     ASNBIFURCATED

EXSPI_SMTPPERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     SMTPMSGSENT
     SMTPMSGRECEIVE
     SMTPBYTESENT
     SMTPBYTERECEIVE
     SMTPMSGBYTESENT
     
SMTPMSGBYTERECEIVE
     SMTPINBOUNDCON
     SMTPOUTBOUNDCON
     
SMTPOUTBOUNDCONREF

EXSPI_IMAP4PERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     IMAP4CON
     IMAP4FAILEDCON
     IMAP4REJECTEDCON
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EXSPI_ISPERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     ISUSERCNT
     ISACTIVEUSERCNT
     ISANONUSERCNT
     
ISACTIVEANONUSERCNT
     ISCONNECTCNT
     
ISACTIVECONNECTCNT

EXSPI_MTAPERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     MTAMSGIN
     MTAMSGOUT
     MTARCPIN
     MTARCPOUT
     MTABYTESIN
     MTABYTESOUT

EXSPI_PORTS
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     PORT_NAME
     PORT_NUMBER
     SERVICE_PROVIDER
     SENT_BYTE
     RECV_BYTE
     RESP_TIME
     CONGFIG_TIMEOUT
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EXSPI_MTADATA
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME 
     INSTANCE_NAME
     MTADATABASEPATH
     MTADATABASESIZE
     MTADATABASEFREE
     MTADATABASETOTAL
     MTADATABASEFP

EXSPI_SMTPDATA
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     INSTANCE_NAME
     SMTPBADMAILDIR
     SMTPBADMAILSIZE
     SMTPBADMAILCNT
     SMTPBADMAILFREE
     SMTPBADMAILTOTAL
     SMTPBADMAILFP
     SMTPPICKUPDIR
     SMTPPICKUPSIZE
     SMTPPICKUPCNT
     SMTPPICKUPFREE
     SMTPPICKUPTOTAL
     SMTPPICKUPFP
     SMTPQUEUEDIR
     SMTPQUEUESIZE
     SMTPQUEUECNT
     SMTPQUEUEFREE
     SMTPQUEUETOTAL
     SMTPQUEUEFP
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EXSPI_MTLDATA
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     MTLPATH
     MTLSIZE
     MTLCNT
     MTLFREE
     MTLTOTAL
     MTLFP

EXSPI_OWAFE
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     OWACONNECTIONS
     
OWAMAXCONNECTIONS

EXSPI_OWABE
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     SERVER_NAME
     OWAMSGSSENT
     OWAMSGSOPEN
     OWAAUTHS
     OWAAUTHSCACHE
     OWARECENTAUTHS

EXSPI_FTIDATA
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     INSTANCE_NAME
     FTILOCATION
     FTISIZE
     FTIFREE
     FTITOTAL
     FTIFP
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EXSPI_SINGLE
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     IMC_IN_MSGS_TOT
     IMC_OUT_MSGS_TOT
     IMC_TOT_IN_KB
     IMC_TOT_IN_RCPIPNTS
     
IMC_TOT_MSGS_QUEUED
     IMC_TOT_OUT_KB
     
IMC_TOT_OUT_RCPIPNTS
     IS_ACTIVE_USER_CNT
     IS_NEWS_MSGS_RECV
     IS_NEWS_MSGS_SENT
     
IS_NEWS_NNTP_POSTED
     IS_NEWS_NNTP_READ
     
IS_PRIV_AVG_DEL_TIME
     IS_PRIV_AVG_LOC_DEL
     IS_PRIV_RECV_QUEUE
     IS_PRIV_SEND_QUEUE
     IS_PUB_AVG_DEL_TIME
     IS_PUB_AVG_LOC_DEL
     IS_PUB_RECV_QUEUE
     IS_PUB_SEND_QUEUE
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     IS_USER_CNT
     VERSION
     RESERVE1
     RESERVE2
     MTA_IN_BYTES_TOT
     MTA_IN_MSGS_TOTAL
     MTA_OUT_BYTES_TOT
     
MTA_OUT_MSGS_TOTAL
     MTA_Q_LEN
     
MTA_TOT_RCPIPNTS_IN
     
MTA_TOT_RCPIPNTS_OUT
     PRIV_FREE_MB
     PRIV_IS_INST_RATIO
     PRIV_IS_LOC_DELIV
     PRIV_IS_LOG_DB_SIZE
     
PRIV_IS_MSG_RCPT_DLV
     PRIV_IS_MSGS_DELIV
     PRIV_IS_MSGS_SENT
     PRIV_IS_MSGS_SUB
     
PRIV_IS_TOTAL_MBOXES
     PRIV_IS_TOTAL_MSGS
     PUB_FREE_MB
     PUB_IS_INST_RATIO
     PUB_IS_LOG_DB_SIZE
     
PUB_IS_MSG_RCPT_DLV
     PUB_IS_MSGS_DELIV
     PUB_IS_MSGS_SENT
     PUB_IS_MSGS_SUB
     
PUB_IS_TOTAL_FOLDERS
     PUB_IS_TOTAL_MSGS

EXSPI_MULTI
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE
     INTERVAL_KEY
     METRIC_ID
     VALUE
     VALUE_ID
     SERVER_NAME

EXSPI_SINGLE
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EXSPI_M0660
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     COUNTER_0660
     INSTANCE_0660
     NUM_BYTES_0660
     NUM_MSGS_0660
     SERVER_NAME

EXSPI_0661
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     COUNTER_0661
     INSTANCE_0661
     NUM_BYTES_0661
     NUM_MSGS_0661
    SERVER_NAME

EXSPI_0662
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     DEST_TYPE_0662
     INSTANCE_0662
     NUM_BYTES_0662
     NUM_MSGS_0662
     SERVER_NAME

EXSPI_0663
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SRC_TYPE_0663
     INSTANCE_0663
     NUM_BYTES_0663
     NUM_MSGS_0663
      SERVER_NAME
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EXSPI_M1002
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     FROMSYSTEM
     INSTANCEVAL
     MEASUREDTIME
     MSE_DEST_SITE
     MSE_ORIG_SITE
     PINGTIMESTAMP
     SLA
     SLAAPPROACH
     TIMEOUT
     TOSYSTEM

EXSPI_CMR
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     READSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY
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EXSPI_CML
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     LOGONSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY

EXSPI_CMS
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     SENDSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY

EXSPI_POP3PERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     POP3CON
     POP3FAILEDCON
     POP3REJECTEDCON
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Service Reporter Schema for Exchange 2007

EXSPI_DELIV
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_KEY
     SERVER_NAME
     DELIVSTATUS
     SLATIME
     SLAPERCENT
     DELIVTOTAL
     PERCENTMET
     TOTALMISSEDSLA
     AVERAGEDELIV
     ORIGSVR
     INTERVAL_KEY

EXSPI_PFDETAIL
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     FOLDER_NAME
     FOLDER_LASTACCESS
     FOLDER_SIZE
     FOLDER_MSGCNT

EX2007_MBDETAIL

MB_IDENTITY

MB_NAME

MB_SVRNAME

MB_SGNAME

MB_DBNAME

MB_SIZE

MB_MSGCOUNT

MB_DISCONNECT
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MB_DELCOUNT

MB_DELSIZE

MB_STGLIMIT

EX2007_MBPERF

INSTANCE_NAME

SERVER_NAME

MBDELIVERYTIME

MBLOCALDELIVER

MBDELIVER

MBSENT

MBSUBMITTED

MBRECIPIENT

MBACTIVELOGON

MBLOGON

MBLOGONPEAK

MBSIRATIO

MBRECOVERITEMS

MBRECOVERSIZE

EX2007_PFPERF

INSTANCE_NAME

SERVER_NAME

PFDELIVERYTIME

PFDELIVER

PFSENT

EX2007_MBDETAIL
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PFSUBMITTED

PFRECIPIENT

PFACTIVELOGON

PFLOGON

PFLOGONPEAK

PFSIRATIO

PFRECOVERITEMS

PFRECOVERSIZE

PFREPRCVD

PFREPSENT

PFREPQ

EX2007_IMAP4PERF

INSTANCE_NAME 

SERVER_NAME

ADMINDISPLAY_NAME

IMAP4CON

IMAP4FAILEDCON

IMAP4REJECTEDCON

EX2007_POP3PERF

INSTANCE_NAME 

SERVER_NAME

ADMINDISPLAY_NAME

EX2007_PFPERF
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POP3CON

POP3FAILEDCON

POP3REJECTEDCON

EX2007_ISPERF

ISUSERCNT

ISACTIVEUSERCNT

ISANONUSERCNT

ISACTIVEANONUSERCNT

ISCONNECTCNT

ISACTIVECONNECTCNT

EX2007_SMTPSEND

INSTANCE_NAME

SERVER_NAME

ADMINDISPLAY_NAME

SMTPMSGSENT

SMTPMSGRECEIVE

SMTPBYTESENT

SMTPBYTERECEIVE

SMTPMSGBYTESENT

SMTPMSGBYTERECEIVE

SMTPINBOUNDCON

SMTPOUTBOUNDCON

SMTPOUTBOUNDCONREF

EX2007_POP3PERF
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EX2007_SMTPRECV

INSTANCE_NAME

SERVER_NAME

ADMINDISPLAY_NAME

SMTPMSGSENT

SMTPMSGRECEIVE

SMTPBYTESENT

SMTPBYTERECEIVE

SMTPMSGBYTESENT

SMTPMSGBYTERECEIVE

SMTPINBOUNDCON

SMTPOUTBOUNDCON

SMTPOUTBOUNDCONREF
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D Embedded Performance Component (EPC) Schema
EXSPI_ASNOTIFY
     ASNTOTAL
     ASNSENT
     ASNIGNORE
     ASNDISCARD
     ASNEXPIRED
     ASNBIFURCATED

EXSPI_ASYNC
    ASYNCUSERS
     ASYNCSENDMAIL
     ASYNCCMDS
     ASYNCCLIENTITEMS
     ASYNCSERVERITEMS
     ASYNCAD
     ASYNCCONNECT
     ASYNCPENDING

EXSPI_CML
     INSTANCE_KEY
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     LOGONSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY
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EXSPI_CMR
     INSTANCE_KEY
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     READSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY

EXSPI_CMS
    INSTANCE_KEY
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     SENDSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY

EXSPI_DELIV
     INSTANCE_KEY
     SERVER_NAME
     STATUS
     SLATIME
     SLAPERCENT
     DELIVTOTAL
     PERCENTMET
     TOTALMISSEDSLA
     AVERAGEDELIV
     ORIGINATING_SERVER
     INTERVAL_KEY

EXSPI_DSACCESS
    CACHEMISSESPERSEC
    CACHEHITSPERSEC
162 Appendix D



EXSPI_FTIDATA
     SERVER_NAME
     INSTANCE_NAME
     FTILOCATION
     FTISIZ
     FTIFREE
     FTITOTAL
     FTIFP

EXSPI_IMAP4
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     IMAP4CON
     IMAP4FAILEDCON
     IMAP4REJECTEDCON
     IMAP4UID

EXSPI_ISCLIENT
     ISCLATENCY10
     ISCLATENCY5
     ISCLATENCY2
     ISCRPCATTEMPT
     ISCRPCSUCCEED
     ISCRPCFAIL
     ISCRPCFUNAV
     ISCRPCFBUSY
     ISCRPCFCANCEL
     ISCRPCFCALLFAIL
     ISCRPCFACCESSDENY
     ISCRPCFOTHER

EXSPI_ISPERF
     RPCREQUESTS
     
RPCOPERATIONSPERSEC
     ISVMLARGESTBLOCK
     ISVMLARGEFREEBB
     ISVM16MBFREE
     ISUSERCNT
     ISCONNECTCNT
     ISANONUSERCNT
     ISACTIVEUSERCNT
     
ISACTIVECONNECTCNT
     
ISACTIVEANONUSERCNT
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EXSPI_M0660
    INSTANCE_KEY
    SERVER_NAME
    INSTANCE_0660
    NUM_BYTES_0660
    NUM_MSGS_0660
    COUNTER_0660

EXSPI_M0661
     INSTANCE_KEY
     SERVER_NAME
     INSTANCE_0661
     NUM_BYTES_0661
     NUM_MSGS_0661
     COUNTER_0661

EXSPI_M0662
    INSTANCE_KEY
     SERVER_NAME
     INSTANCE_0662
     NUM_BYTES_0662
     NUM_MSGS_0662
     DEST_TYPE_0662
     COUNTER_0662

EXSPI_M0663
     INSTANCE_KEY
     SERVER_NAME
     INSTANCE_0663
     NUM_BYTES_0663
     NUM_MSGS_0663
     SRC_TYPE_0663
     COUNTER_0663

EXSPI_M1002
     INSTANCE_KEY
     INTERVAL_KEY
     SERVER_NAME
     MSE_ORIG_SITE
     MSE_DEST_SITE
     PINGTIMESTAMP
     FROMSYSTEM
     TOSYSTEM
     INSTANCEVAL
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
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EXSPI_MBDETAIL
     INSTANCE_KEY
     INTERVAL_KEY
     MAILBOX_NAME
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     MAILBOX_SIZE
     MAILBOX_QUOTA
     MAILBOX_MSGCNT
     MAILBOX_LASTACCESS

EXSPI_MBPERF
      INSTANCE_NAME
      SERVER_NAME
      MBSENDQ
      MBRECEIVEQ
      MBDELIVERYTIME
      MBLOCALDELIVER
      MBDELIVER
      MBSENT
      MBSUBMITTED
      MBRECIPIENT
      MBACTIVELOGON
      MBLOGON
      MBLOGONPEAK
      MBSIRATIO
      MBRECOVERITEMS
      MBRECOVERSIZE

EXSPI_MBSUMMARY
     INSTANCE_KEY
     
STORAGEGROUP_NAME
     DATABASE_NAME
     SERVER_NAME
     ADMINGROUP
     EDBPATH
     STMPATH
     EDBSIZE
     STMSIZE
     EDBFREE
     STMFREE
     EDBTOTAL
     STMTOTAL
     MBLOGICALSIZE
     MAILBOX_USRCNT
     MAILBOX_MSGCNT
     INTERVAL_KEY
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EXSPI_MTADATA
     SERVER_NAME
     INSTANCE_NAME
     MTADATABASEPATH
     MTADATABASESIZE
     MTADATABASEFREE
     MTADATABASETOTAL
     MTADATABASEFP

EXSPI_MTAPERF
     MTAWORKQ
     MTAMSGIN
     MTAMSGOUT
     MTARCPIN
     MTARCPOUT
     MTABYTESIN
     MTABYTESOUT

EXSPI_MTLDATA
     SERVER_NAME
     MTLPATH
     MTLSIZE
     MTLCNT
     MTLFREE
     MTLTOTAL
     MTLFP

EXSPI_MULTI
     INSTANCE_KEY
     SERVER_NAME
     METRIC_ID
     VALUE_ID
     INSTANCE
     VALUE
     INTERVAL_KEY

EXSPI_OMA
     OMASENT
     OMAIGNORE
     OMADISCARD
     OMARESPONSE

EXSPI_OWABE
     INSTANCE_NAME
     SERVER_NAME
     OWAMSGSSENT
     OWAMSGSOPEN
     OWAAUTHS
     OWAAUTHSCACHE
     OWARECENTAUTHS
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EXSPI_OWAFE
     INSTANCE_NAME
     OWACONNECTIONS
     
OWAMAXCONNECTIONS

EXSPI_PFDETAIL
     INSTANCE_KEY
     INTERVAL_KEY
     FOLDER_NAME
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     FOLDER_SIZE
     FOLDER_MSGCNT
     FOLDER_LASTACCESS

EXSPI_PFPERF
     INSTANCE_NAME
     SERVER_NAME
     PFSENDQ
     PFRECEIVEQ
     PFDELIVERYTIME
     PFDELIVER
     PFSENT
     PFSUBMITTED
     PFRECIPIENT
     PFACTIVELOGON
     PFLOGON
     PFLOGONPEAK
     PFSIRATIO
     PFRECOVERITEMS
     PFRECOVERSIZE
     PFREPRCVD
     PFREPSENT
     PFREPQ
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EXSPI_PFSUMMARY
     INSTANCE_KEY
     
STORAGEGROUP_NAME
     DATABASE_NAME
     SERVER_NAME
    ADMINGROUP
     EDBPATH
     STMPATH
     EDBSIZE
     STMSIZE
    EDBFREE
     STMFREE
     EDBTOTAL
     STMTOTAL
     PFLOGICALSIZE
     FOLDER_COUNT
     FOLDER_MSGCNT
     INTERVAL_KEY

EXSPI_POP3
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     POP3CONN
     POP3FAILEDCON
     POP3REJECTEDCON
     POP3DELE
     POP3RETR

EXSPI_PORTS
     SERVER_NAME
     PORT_NAME
     PORT_NUMBER
     SERVICE_PROVIDER
     SENT_BYTE
     RECV_BYTE
     RESP_TIME
     CONFIG_TIMEOUT

EXSPI_SINGLE
     Version
     Reserve 1
     Reserve 2
     IS Active User Count
     IS User Count
     MTA Inbound Msgs Tot
     MTA Outb. Msgs Tot
     MTA Tot. Recip. Inb.
     MTA Tot. Recip. Outb
     MTA Inb. Bytes Total
     MTA Out. Bytes Total
     Priv.IS Local Deliv.
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     Priv.IS Msgs Deliv.
     Priv.IS Msgs Sent
     Priv.IS Msgs Submit.
     Priv.IS Recip. Deli.
     Pub.IS Msgs Deliv.
     Pub.IS Msgs Sent
     Pub.IS Msgs Submit.
(cont.)
     Pub.IS Recip. Deliv.
     Newsfeed Msgs Sent
     Newsfeed Msgs Receiv
     NNTP Messages Read
     NNTP Messages Posted
     MTA Queue length
     Priv.IS Send Queue
     Priv.IS Recei. Queue
     Pub.IS Send Queue
     Pub.IS Recei. Queue
     Priv.IS Avg Local
     Priv.IS Avg Delivery
     Pub.IS Avg Local
     Pub.IS Avg Delivery
     IMC In Msgs Total
     IMC Out Msgs Total
     IMC Total In (KB)
     IMC Total Out (KB)
     IMC Tot. In Recip.
     IMC Tot. Out Recip.
     IMC Tot. Msgs Queued
     Priv.IS DB Size (MB)
     Priv. IS Tot. MBoxes
     Priv. IS Tot. Mesgs
     Priv. IS Log.DB Size
     Priv. IS Inst. Ratio
     Pub. IS DB Size (MB)
     Pub. IS Tot. Folders
     Pub. IS Tot. Mesgs
     Pub. IS Log. DB Size
     Pub. IS Inst. Ratio
     SERVER_NAME

EXSPI_SINGLE
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EXSPI_SMTPDATA
     SERVER_NAME
     INSTANCE_NAME
     SMTPBADMAILDIR
     SMTPBADMAILSIZE
     SMTPBADMAILCNT
     SMTPBADMAILFREE
     SMTPBADMAILTOTAL
     SMTPBADMAILFP
     SMTPPICKUPDIR
     SMTPPICKUPSIZE
     SMTPPICKUPCNT
     SMTPPICKUPFREE
     SMTPPICKUPTOTAL
     SMTPPICKUPFP
     SMTPQUEUEDIR
     SMTPQUEUESIZE
     SMTPQUEUECNT
     SMTPQUEUEFREE
     SMTPQUEUETOTAL
     SMTPQUEUEFP

EXSPI_SMTPPERF
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     SMTPMSGSENT
     SMTPMSGRECEIVE
     SMTPBYTESENT
     SMTPBYTERECEIVE
     SMTPMSGBYTESENT
     
SMTPMSGBYTERECEIVE
     SMTPINBOUNDCON
     SMTPOUTBOUNDCON
     
SMTPOUTBOUNDCONREF

EXSPI_SMTPQ
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     REMOTERETRYQ
     REMOTEQ
     LOCALRETRYQ
     LOCALQ
     PENDINGROUTINGQ
     CATEGORIZERQ
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EXSPI_SRS
     SRSDIRPATH
     SERVER_NAME
     SSRSDIRSIZE
     SRSDIRFREE
     SRSDIRTOTAL
     SRSDIRPF
     INTERVAL_KEY

EXSPI_TRANSLOG
     
STORAGEGROUP_NAME
     SERVER_NAME
     TRANSLOGFILEPATH
     TRANSLOGFILESIZE
     TRANSLOGFILEFREE
     TRANSLOGFILETOTAL
     TRANSLOGFILEFP
     INTERVAL_KEY
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E Creating Service Accounts for Exchange 2000 
or 2003
The Exchange SPI collects data from many sources. To collect the many types of data, the 
Exchange SPI requires advanced user credentials. The simplest way to obtain these 
credentials is to have the OVO management agent run as Local System. If this is not possible 
in your organization, you must create a special service account with the necessary privileges. 

Task 1: Create service account 

1 Log on to the system that hosts the managed node’s domain.

2 Select Start > Settings > Control Panel > Administrative Tools > Active Directory 
Users and Computers.

3 Expand the Active Directory Users and Computers and right-click Users and select New 
> User,
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4 In the New Object - User dialog, enter a user name for the new service account into the 
First Name and the User logon name fields.  

  

5 In the next window, enter Password/Confirm Password for the service account.

6 Select Password Never Expires. Then click Next.

You must create a service account with these privileges in each Windows domain. You 
may use any user name you wish. This example uses MSXSPI as the user name for the 
service account. 
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7 In the New Object dialog, deselect Create an Exchange mailbox, and click Next

   

8 In the next dialog, complete creating the user by clicking Finish.
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9 You are now back at the Active Directory Users and Computers dialog. In the right 
pane, right-click on the service account user just created and select Properties.

10 In the service account Properties page, select the General tab. Enter OVO Exchange 
SPI in the Display name and Description fields.

  

11 Select the Member Of tab, and click Add.

12 In the Select Group dialog select Exchange Domain Servers from the top pane. Click 
Add, then OK.

13 The new user is now a member of Domain Admins group. Click OK and exit the Active 
Directory Users and Computer dialog.
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Task 2: Add service account user to Local Administrators group

1 On each targeted Exchange 2000/2003 server, select Start > Settings > Control Panel. 

2 Double click Administrative Tools. Double click Computer Management, then open 
the Local Users and Groups folder. Select and open the Groups folder, then double 
click Administrators.

3 In the Administrators Properties dialog, click the Add button. Select the correct 
Domain from the Look in drop down list. Select the new service account user from the 
list, and click Add.

4 Update the discovery policy EXSPI-6.0 Exchange Service Discovery, to include this new 
user.

5 This procedure needs to be carried out for each targeted Exchange 2000/2003 server.  

It can sometimes take a few hours for new group membership and rights to be 
applied to a service account. 
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F Exchange Cluster Terminology
Cluster

A cluster is a group of independent computers, called nodes, that present themselves to a 
network as a highly available single system.

Node

A system that is a member of a cluster, and has a working installation of the Cluster Service. 

Resources

Resources are physical or logical entities, such as applications, or services, under the control 
of the Cluster Service.

Cluster Resource Group

A Cluster resource group is a set of resources that are grouped together to be managed as a 
single unit for configuration and recovery purposes. Each resource in a resource group may be 
dependent on other resources within that group.

A resource group is the unit of failover in a cluster. 

Failover

Failover is the process of moving a resource group from one node to another in the case of a 
failure. A failover can occur automatically, in the case of a problem, or manually, initiated by 
an administrator.

Failback

Is the process of returning a resource group to the node on which it was running before a 
failover happened.

Active/passive

A cluster is in Active/Passive mode when one node is active while another is passive/idle. Only 
when the active node fails or is taken offline, will the passive node becomes active.

Active/active

Each node is assigned some of the workload and process requests from clients. When one node 
fails or is taken offline, control of its resources are passed to the other node.

Virtual Server

A virtual server is a resource group and contains:

• A Network Name resource

• An IP Address resource

• The resources to be accessed by the clients of the virtual server.
 179



A virtual server acts as a standalone system. Clients on the network interact with the virtual 
server just as if it were a physical server.

Exchange Server Cluster 

To create an Exchange Server cluster, services provided by the Windows Cluster service are 
needed. Microsoft Exchange Server installs custom files and resources when installing the 
cluster-aware version of Exchange. This cluster-aware version of Exchange is installed when 
Exchange Server Setup is run on a node of a Windows Server cluster.

Exchange Virtual Server (EVS)

If Exchange is installed in a Windows Cluster; the EVS is the network name of a cluster 
resource group which contains:

• A Network Name resource

• An IP Address resource

• A Disk Resource on a common storage subsystem.

Additional resources represent the various components of Exchange:

— System Attendant

— Information Store

— Routing

— Message Tracking Agent

— MSSearch

— Protocol

— SMTP

— HTTP

— POP3

— IMAP

 The EVS runs as a unit on one node in the cluster at any given time. It may also be limited to 
a subset of the total nodes in the cluster.
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A
Adding or modifying a collection definition, 74

Advanced Exchange Data Collection, 128

AlmostMetSLA, 61

Auto Deploy policies
Exchange 2000, 84, 91

C
Client SLA Configurations, 122

cluster support, 67, 179

cluster terminology, 179

D
DataStore, 73

destination mailbox, 61

E
End-to-End Message Ping alarms, 62, 63

Exchange Topology viewer
using, 125

G
graphs

Exchange 2000 graphs, 117
Exchange 2003 graphs, 117
Exchange 5.5, 119

I
instrumentation files, 137

M
mailboxes, creating, 58

managed node, 9

managed nodes
add nodes, 23, 35, 50

management server, 9

manual deployment
Exchange 2000 and 2003, 98

Manual Deploy policies
Exchange 2000, 97
Exchange 2003, 90

map view, 11

message alerts, 11

messages
enabling tracking

5.5 servers, 105
testing delivery/receipt, 60, 62

MetricSet, 73

MetSLA, 61

O
OpcMon, 73

OpcMsg, 73

OVO agent, 9

OV Topology Viewer, 123
map, modifying display of, 130
moving sites outside map, 130

P
passwords

modifying the EXPSI Reporter Collection 
Policies, 102

policies
creating new group, 141
customizing, 142
modifying to include service account password, 

63
tagging, 141, 142

policy group descriptions
Exchange 5.5, 100

PowerShell collection configuration utility, 74
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procedures
mailboxes, creating, 59
message tracking, enabling

5.5 servers, 105
policies

creating a new group, 141
tagging, 141, 142

Reporter Collection Policies
editing, 103

Reporter Collection Policies, deploying, 103
servers, configuring, 62
service accounts

creating in W2k/Ex2000 or 2003, 173, 176

R
Refresh Collection Definition policy, 31

Register DataCollector tool, 28

Reporter Collection Policies
deploying, 103

reports
Exchange 5.5, 102
time interval for generation, 105

reports and graphs, 12

S
servers, configuring, 62

service accounts
creating

W2k/Ex 2000 or 2003, 176
W2k/Ex2000 or 2003, 173

mailboxes, creating, 59
modifying the EXSPI Report Collection Policies 

to include passwords, 102
password, modifying policy to include, 63

Service Reporter schema, 143

Site Topology, 129

SLA
for Exchange 2000/2003, 54
for Exchange 5.5, 58

source mailbox, 61

source server, 61

Start ExData Collection Manager tool, 28

Start PowerShell Collector tool, 29

T
tag feature, using, 141

timeout, 61

tools
Configure Client MAPI Logon, 122
Configure Client Message Read, 122
Configure Client Message Send, 122
Embedded Performance Component 

Configuration, 124
Enable Message Tracking, 122
End-to-End Configuration, 122
Exchange Cluster Configuration tool, 124
MBOX Config, 122
MBOX creation for MAPI client based policies, 

122
Mount Exchange Information Store, 122
OV Topology Viewer

data collection permissions, 128
getting started with, 129
map, changing, 130

Self Healing Info, 122
Trace On/Tracing Off tools, 122
tracing, 124

topology viewer, 12

U
Using additional cmdlets, 76
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